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PREFACE

Susan Kennard, Director and Executive Producer
Banff New Media Institute
The Banff Centre

On behalf of The Banff New Media Institute (BNMI) and The Banff Centre, it is my 
pleasure  to  welcome the  fellows,  faculty  and  guests  of  the  Canadian  Women in 
Communications/Corus New Media Career Accelerator Workshop.

The  BNMI  aims  to  be  an  active  participant  in  the  professional  development, 
production, research and critical reception of artists, producers and companies who 
work in the broad realm of  the media arts.  The BNMI is  not about borders, but 
instead chooses to engage in the hybrid articulation of new media that emerges over 
time – be it culture, knowledge, content, technology, industry or art. 

Here we are now in 2006, a point and time when the notion of new media needs 
careful reflection and analysis. This moment to us represents, to borrow a phrase 
from Alvin Toffler, the first wave of media arts drawing to a close and the beginning 
of the second wave. We are engaged in a process of dealing with the tensions of both 
trying to mature and deepen practice but at the same time recognizing that as an 
institute dedicated to new media we must have the aptitude to continually connect to 
newness,  nimbleness,  innovation  and  the  next  generation  of  discovery.  As 
participants in this workshop you too are choosing to actively engage in the ‘second 
wave’ of the intangible yet pervasive phenomenon of new media.  We welcome your 
participation and endeavour to provide you with a supportive and unique learning 
opportunity that will challenge you, inspire you and connect you to an exploration of 
new media as part of our living culture.  

The Banff New Media Institute builds on the history of The Banff Centre. For almost 
75 years, the impact of the inspiring mountain location, the creative atmosphere, the 
diverse group of participants from many backgrounds and disciplines, and the strong 
support  from Centre  staff  have combined to make a powerful  experience that  is 
stimulating to mind, body and spirit.  You are in good company here in Banff, both 
with the colleagues you will be working with over the next seven days and with your 
peers across the campus. 

I would like to give special recognition and thanks to our partners and sponsors in 
this workshop, Corus Entertainment Inc. and Canadian Women in Communications 
(CWC).  It is through their support and generous collaboration that this workshop 
was realized in 2001 and continues on today and into the future, to the benefit of 
women working in media and communications across the entire country. 

Good luck and have fun!





BNMI COORDINATOR’S WELCOME   

Emily Paige, BNNI Coordinator
The Banff New Media Institute
The Banff Centre

Thank you for attending the CWC/Corus New Media Accelerator Program.  The next 
week promises to be exciting and provocative, featuring faculty and presenters from 
diverse new media backgrounds and an agenda which has been fine tuned to provide 
a delicate balance of intensity and fun.  

Although the entire BNMI team has been contributing to this program, it is Iwona 
Erskine-Kellie who deserves a special mention.  Iwona's extensive knowledge of new 
media issues, her creativity and her technical skills have helped to bring this program 
together.  Three cheers to Iwona and all of her hard work!

Having read over all of the applications and the bios, I am very much looking forward 
to interacting with such an esteemed group of people and to the excitement ahead. 
A program that is committed to advancing women in the workplace and to supporting 
their professional growth is something that should be celebrated.  The fact that it is 
taking place at The Banff Centre ensures that the next week's learning will be distinct  
and meaningful – resonating long after we’ve all returned to our day to day lives.  

Please take advantage of the scenery and opportunities that such a magical place has 
to offer and, above all, enjoy!





CWC/CORUS NEW MEDIA CAREER ACCELERATOR – 2006

OVERVIEW

The New Media Career Accelerator Program is a unique, industry-specific professional 
development program that  is  focused on advancing women who work  within  the 
communications field.  It will open up new doors and opportunities for a group of 
highly talented women who will make significant contributions to the industry in the 
years ahead.

Funded by Corus Entertainment Inc, The New Media Career Accelerator Program is an 
intensive seven-day executive training program that is challenging and leading-edge. 
The course will  take participants through the technology, terminology, possibilities 
and  power  of  new  media  under  the  direction  of  some  of  North  America’s  most 
respected media experts and provide them with the insights and strategies they need 
to manage new media aspects of their job. 

The programming offers a sound grounding in new media content development and 
producing, which includes a discussion on future trends in new media, mobile content 
and  technologies,  interactive  games,  the  challenge  of  converging  industries  and 
processes,  and  legal  strategies  and  trends.   This  is  an  opportunity  for  the 
participating women to network and support each other.





CAMPUS MAP

THE TOWN OF BANFF



GENERAL INFORMATION

Registration Packages
Registration packages  will  be  provided upon 
check  in  at  the  Professional  Development 
Centre.

Meals
The  Banff  Centre  dinning  room  services: 
breakfast (7:00am-9:00pm), lunch (11:30am-
1:30pm) and dinner (5:30pm-7:30pm). Your 
photo  identification  card  will  get  you 
access to the dining room.  For details on 
getting your photo identification card, please 
see your welcome package that was supplied 
to you at check in. 

Snack Bars
For quick snacks and light meals there are two 
facilities  available  during  day  time  on  the 
campus- Kiln and Gooseberry Juice Bar  and 
Deli. For more details, check: 
http://www.banffcentre.ca/facilities/dining

Technology
Full  technical  services  will  be  provided  to 
facilitate all forms of presentations. On days 
you are scheduled to give a presentation, you 
are required to do a technical run through. A 
Technical Run Through schedule can be found 
in your welcome package that was given to 
you at the check-in.

Email Services
Complimentary  Wireless  Internet  access  is 
available  in  most  areas  around  campus.  All 
Banff  Centre  accommodation  rooms  have 
data-ports  in  the  phones  for  working  or 
checking e-mail on a laptop. Standard long-
distance  charges  apply  as  well  as  a  0.75 
connection  fee  for  all  long  distance  calls. 
Throughout  The  Banff  Centre  there  are  PCs 
(Macintosh  or  MS  Windows)  for  guest  and 
artist use. Two are located in the Paul D. Fleck 
Library  (lower  level  of  Lloyd  Hall),  one  in 
Glyde Hall,  and two located in the Business 
Centre. In Banff, there are two Internet cafes, 
located  in  the  Bear  Street  Mall  and  in  the 
lower level of Sundance Mall.

Photocopying
Photocopying  can  be  done  at  the 
Switchboard/Business Centre in DCH (Donald 
Cameron Hall). Hours of operations: 8.30am – 
6.00pm on all days of the conference. Xerox - 
The Document Source is located on-site and 

may  be  able  to  complete  larger  jobs  with 
advance notice.

Currency Exchange
CIBC bank on the Banff Avenue is the closest 
place  that  does  immediate  currency 
exchanges. The Bank may levy extra charges 
to  non-account  holders  for  all  currency 
exchanges,  and  it  doesn’t  necessarily  make 
exchanges for all currencies.

Smoking
There are a limited number of bedrooms that 
can  accommodate  smoking.  For  the  health, 
safety and comfort of our guests, The Banff 
Centre  has  designated  all  public  areas, 
classrooms,  performance spaces and service 
areas  as  non-smoking.  Smoking  is  not 
permitted  in  building  entrance  areas,  or  on 
outside patios where food service is available. 
All  rooms  in  the  Professional  Development 
Centre are non-smoking. 
For  our  guests  who  smoke,  smoking  room 
accommodation is available in Lloyd Hall. To 
provide other  comfortable  smoking  locations 
the Centre has designated more than twenty 
outdoor  smoking  areas,  at  outlined  on  the 
campus map.

Disabled Access
There  are  paths,  roadways  and  ramps 
throughout  most  buildings.  Some  bedrooms 
have been adapted for wheelchair access and 
some  phones  in  Donald  Cameron  Hall  are 
positioned  at  a  lower  level  for  wheelchairs. 
The Banff Centre was built on the side of a 
mountain,  however, and presents  challenges 
to people with limited mobility. On the sixth 
floor of Lloyd Hall there is a phone equipped 
with  an  amplifier  handset  for  the  hearing 
impaired.

Transportation
The Banff Centre is located on the east side of 
Banff, four blocks from Banff Ave. The town 
can be accessed by foot three ways from the 
Centre grounds: St-Julien Rd., Buffalo St., and 
the  Ken  Madsen  Path  to  town.  It  is 
approximately a 10-15 minute walk downhill 
to town. The return trip is slightly longer as it 
is  uphill.  There  is  no  shuttle  bus  that  runs 
from  The  Banff  Centre  to  downtown  Banff. 
Downtown Banff  can be reached by taxi  for 
less  than  $5.00  each  way.  Bus  service is 
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available from Calgary International Airport to 
Banff  and Lake Louise hotels through  Banff 
Airporter and  Brewster  Transportation. 
Banff  Airporter is  the  official  airport  shuttle 
provider  of  The  Banff  Centre.  Multiple  daily 
transfers  run  between  the  Calgary 
International Airport and The Banff Centre for 
approximately $47 (Cdn) one-way / $88 (Cdn) 
return.  Reservations  are  necessary;  please 
call 1-888-HIWAY-01 in North America, or visit 
For Brewster  coaches,  two departures  leave 
daily  from  Calgary  International  Airport  to 
Banff hotels, and three return daily from Banff 
to  the  airport.  Fare  is  approximately  $42 
(Cdn),  one-way.  Please  contact  directly,  to 
confirm  times  and  prices -  Brewster 
Transportation (U.S. and Canada 1-800-661-
1152,  all  other  403-762-6700) or  visit  their 
website to confirm times and rates. 
www.brewster.ca/day_trips/airporter_schedule
s.asp

Parking
There is parking available on site at The Banff 
Centre. There is a two-level parkade as well 
as  a  lot  located  next  to  the  Professional 
Development Centre, close to the Front Desk 
and Reception. Parking is  complimentary for 
Banff Centre guests and we require a pass to 
be placed on the dash of your car, which you 
will receive upon check-in. Our parking areas 
are  patrolled  on  a  regular  basis  by  on-site 
security. As thefts can occur, we suggest that 
all valuables be removed from view in the car. 

The Banff Centre is not responsible for theft or 
damage to vehicles while parked on our site.

Wellness
The Banff Centre experience isn't only about 
nurturing  artistic  and  intellectual  innovation. 
Creativity requires a healthy body as well as a 
healthy  mind,  and  Sally  Borden  Fitness  & 
Recreation offers a wide range of recreational 
opportunities  and fitness services for  people 
of all abilities and interests. 
Check: http://www.banffcentre.ca/sbb/health

What is the 7% GST (Goods and Services 
Tax)?
Canada imposes a 7% tax on all  goods and 
services  purchased  in  Canada.  This  can  be 
refunded  in  full  to  non-Canadian  residents 
upon application. Applications can be obtained 
at the Front Desk or in the town of Banff at 
various restaurants, shops and hotels. There 
are two ways to apply:

F-1 Refund Services Inc.
P.O. Box 219, Suite 9100, 
Banff, Alberta, Canada T0L 0C0

Revenue Canada Visitor Rebate Program
Summerside Tax Centre, Summerside, 
P.E.I., Canada, C1N 6C6

Phone toll free from anywhere in Canada: 
1-800-668-4748
From outside Canada: 
902-432-5608



CWC/Corus New Media Career Accelerator Workshop
February 24th – March 3rd, 2006

14



WORKSHOP PROGRAM 

FRIDAY FEBRUARY 24

TECHNICAL RUN THROUGH 
8:30pm – 9:30pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

*ALL PRESENTERS FOR THE DAY MUST ATTEND - see technical run through schedule 
for times.

MEET AND GREET
8:00pm – 10:00pm     TransCanada PipeLines Pavilion (TCPL) Foyer

There will be opportunity to introduce yourself and meet other fellows and faculty, 
share a glass of wine or have a cup of tea and nestle in for your first night in the 
mountains. 

SATURDAY FEBRUARY 25 

BREAKFAST
7:00am - 9:00am                       Banff Centre Dining Room

TECHNICAL RUN THROUGH 
7:30am – 9:00am                 TransCanada PipeLines Pavilion (TCPL), Room 201

*ALL PRESENTERS FOR THE DAY MUST ATTEND - see technical run through schedule 
for times.

WELCOME AND ORIENTATION
9:00am - 10:00am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Susan Kennard, Director and Executive Producer, The Banff New Media Institute, 
The Banff Centre
Stephanie MacKendrick, President, Canadian Women in Communications
Deborah Beatty, Vice President Corus and Nelvana Interactive

CWC/Corus New Media Career Accelerator Workshop
February 24th – March 3rd, 2006
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SATURDAY FEBRUARY 25 

Faculty Introduction: 
Marty  Avery, Chief  Catalyst,  What  If?;  Jane  Arnot, Senior  Director,  Business 
Development,  CanWest  Global  Communications,  Inc. ; Michel  Blondeau, CEO, 
Ecentricarts Inc.; Jan Bozarth, President, Blue Arrow Music;
Lili Campbell, President and Creative Director, Footprint Strategic Communications Inc.; 
Sheelagh Carpendale, Canada Research Chair and Associate Professor Department of 
Computer  Science  and  Faculty  of  Communication  and  Culture  University  of  Calgary; 
Iwona  Erskine-Kellie,  BNMI  Assistant  &  New  Media  Artist;  Susannah  Gardner, 
Creative Director, Hop Studios, Author, ‘Buzz Marketing with Blogs for Dummies’;  Judy 
Gladstone, Executive  Director,  Bravo!FACT  and  MaxFACT   (Foundations  to  Assist 
Canadian Talent); Cristi Hawtin, Global Product Manager, ALIAS Systems;  Christene 
Hirschfeld, Partner, Boyne Clarke Barristers & Solicitors; 
Penny Jennett, Professor - Faculty of Medicine, University of Calgary; 
Cheryl  L'Hirondelle,  Independent  Interdisciplinary  Artist; Jo  Morrison,  Creative 
Director, NESTA Future Labs; Lally Rementilla,  VP of Business Planning and Analysis,  
Lavalife Corp.; Elizabeth Vander Zaag, Media Artist

Introductions to the program, faculty, and participants.

THE CURRENT STATE OF CONSOLIDATION AND ITS IMPLICATIONS
10:00am - 11:00am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Introduction by: Susan Kennard, Director and Executive Producer, The Banff New 
Media Institute, The Banff Centre

Deborah Beatty, Vice President Corus and Nelvana Interactive

Keynote address on the current state of the industry, the process of consolidation 
(concentration of ownership and vertical integration in media) and the knowledge and 
skills needed to lead in a time of change. 

COFFEE BREAK
11:00am - 11:15am

CWC/Corus New Media Career Accelerator Workshop
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SATURDAY FEBRUARY 25 

CASE STUDY: SHORTS IN MOTION: PHASES I AND II
11:15am - 12:15pm       TransCanada PipeLines Pavilion (TCPL), Room 201

Introduction by: Susan Kennard, Director and Executive Producer of The Banff 
New Media Institute, The Banff Centre

Judy Gladstone,  Executive  Director,  Bravo!FACT and  MaxFACT  (Foundations  to 
Assist Canadian Talent)

Case study of a project conceived at the CWC / Corus New Media Career Accelerator 
workshop in 2004: Discussion of the growth of a project, involving both new and old 
media,  from  conception  to  execution,  including  identifying  appropriate  partners, 
marketing and the launch.

LUNCH
12:15pm - 1:15pm                      Banff Centre Dining Room

CONTENT DEVELOPMENT FOR THE NEW "DIGITALLY ORGANIC" FAMILY
1:15pm - 2:00pm                           TransCanada PipeLines Pavilion (TCPL), Room 201

Introduction by: Susan Kennard, Director and Executive Producer of The Banff 
New Media Institute, The Banff Centre

Jan Bozarth, President, Blue Arrow Music

What’s new for girls in the gaming world not what’s out, what’s coming? Girls Use of 
cell phones, IM’s, and Blogs - Girls, phones, talking, gossip, diaries and secrets.

Today’s female  consumers  comprise  the  most  powerful  buying  group  in  history. 
Savvy businesses are listening to women and girls and making a space for their ideas, 
issues and desires. Within the context of ‘The Digital Family’, we’ll  identify who is 
using what digital media and technology, and consider how this affects the family, 
communications and entertainment. What formats are delivering this new material 
and how do various formats  cross over? A case study of  a  new media  brand in 
development.

CWC/Corus New Media Career Accelerator Workshop
February 24th – March 3rd, 2006

17



SATURDAY FEBRUARY 25 

MMORPG AS A MARKETING TOOL?
2:00pm – 2:45pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

Introduction by: Susan Kennard, Director and Executive Producer of The Banff 
New Media Institute, The Banff Centre

Marty Avery, Chief Catalyst, What If?

Who says you can’t make money playing ‘video’ games? Massively Multiplayer Online 
Role-Playing  Games  (MMORPG’s)  are  growing  loyal  players  and  international 
economies. Busy people use MMORPGs to connect, unwind and make money. Social 
therorists and architects are using MMORPGs to test concepts and build models. How 
big is this phenomenon? Where will it go? What are the implications for the future?

WEB 2.0, SOCIAL SOFTWARE AND BLOGS:
TECHNOLOGIES THAT ARE TRANSFORMING OUR LIVES
2:45pm – 4:00pm                           TransCanada PipeLines Pavilion (TCPL), Room 201

Introduction by: Iwona Erskine-Kellie, BNMI Assistant & New Media Artist, The 
Banff Centre

Susannah Gardner, Creative Director, Hop Studios, Author, Buzz Marketing with Blogs 
for Dummies

Elizabeth Vander Zaag, Media Artist

This panel will introduce you to the technology trends in the Web 2.0/social software 
space. Get a grasp on the business and cultural implications of these next-generation 
ideas, with examples of how they are being used online today. Bonus: Jargon brush-
up! Learn buzzwords and tech-speak galore while we tour wikis, blogs, RSS, photo-
sharing and more.  We’ll wind up this  session with an overview of  how blogs are 
changing the way businesses reach and interact with customers.

If you have a laptop with you, be sure to bring it to this session, so you can look at 
some of the great web sites we’ll be touring.

COFFEE BREAK
4:00pm - 4:15pm

CWC/Corus New Media Career Accelerator Workshop
February 24th – March 3rd, 2006
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SATURDAY FEBRUARY 25 

PARTICIPANT SHOW AND TELL
4:15pm – 6:15pm                           TransCanada PipeLines Pavilion (TCPL), Room 201

Susan Kennard, Director and Executive Producer of The Banff New Media Institute, 
The Banff Centre

Each participant shall have 5 minutes to introduce themselves and their work

EXPLANATION OF THE PITCHING EXERCISE
6:15pm- 6:45pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

Marty Avery, Chief Catalyst, What If?   

Nothing happens without committed resources. Given two minutes, what will you say 
to attract collaborators, investors and customers to you? Once you have their eyes 
and ears, what will you say and do to gain their trust? This presentation covers key 
concepts for persuading the right money and people to support your project or 
business. Learn the foundational Mind Set and Approach to create the winning pitch. 

Structure and Content, Delivery Style, Closing, and Follow up will be outlined to 
prepare for the forthcoming pitching exercise. 

DINNER* 
6:45pm - 8:00pm                 Banff Centre Dining Room

NOTE: *Last service in the dining room is at 7:30pm.  After dinner, please 
change into something that will be fitting for the play-with-clay session.

THE TACTILE VOICE - CERAMIC CREATIVITY SESSION
8:00pm - 10:00pm                    Glyde Hall, Studio 17

Ed Bamiling, Ceramics Facilitator, Visual Arts Department, The Banff Centre

This  is  a  hands-on creativity session which offers  Fellows the 
opportunity to explore visual imagery through the tactile medium 
of clay.  The module embraces concepts of communication, self-
awareness,  cooperation,  team-building,  brainstorming,  some 
creative risk-taking and enjoyment - in an informal, supportive 
environment  with  license  to  experiment  and  indulge  one’s 
imagination.  

Wine and Beer will be served.

CWC/Corus New Media Career Accelerator Workshop
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SUNDAY FEBRUARY 26 

BREAKFAST 
7:00am - 9:00am                                  Banff Centre Dining Room

TECHNICAL RUN THROUGH 
8:30am – 9:00am                 TransCanada PipeLines Pavilion (TCPL), Room 201

*ALL PRESENTERS FOR THE DAY MUST ATTEND - see technical run through schedule 
for times.

HIGHLIGHTS OF THE PREVIOUS DAY
9:00am - 9:30am       TransCanada PipeLines Pavilion (TCPL), Room 201

Susan Kennard, Director and Executive Producer, The Banff New Media Institute, 
The Banff Centre

PITCHING STRATEGIES: WITHIN ORGANIZATIONS
9:30am - 10:30am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Deborah Beatty, Vice President Corus and Nelvana Interactive

COFFEE BREAK
10:30am - 10:45am

$, RIGHTS AND NEW MEDIA 
10:45am - 11:45pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

Christene Hirschfeld, Partner, Boyne Clarke Barristers & Solicitors

What are rights issues in current new media deals? How should deals be negotiated to 
get  the  best  out  of  potential  properties?   Legal  issues  to  consider  in  online 
environments.

CWC/Corus New Media Career Accelerator Workshop
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SUNDAY FEBRUARY 26 

WINNING BY OFFERING THE BEST OF OFFLINE AND ONLINE TO 
ADVERTISERS AND CONSUMERS
11:45am - 12:30pm        TransCanada PipeLines Pavilion (TCPL), Room 201

Jane Arnot, Senior Director, Business Development, CanWest Global 
Communications, Inc. 

Online is often a very small but important and fast moving part of a traditional company - 
especially a multi-media company like CanWest. Working together with colleagues in all 
areas of the company requires sensitivity, time and the ability to understand all 
perspectives. We will cover some of the ways that CanWest has been successful by 
aligning all of our assets to deliver true-multi media offerings in our Classifieds business 
that bring the best of all worlds to our advertisers and consumers.

LUNCH
12:30pm – 1:30pm               Banff Centre Dining Room

THE LAVALIFE MODEL AND ITS EXPERIENCE WITH THE FEMALE MARKET 
1:30pm - 2:45pm       TransCanada PipeLines Pavilion (TCPL), Room 201

Lally Rementilla, VP of Business Planning and Analysis, Lavalife Corp.

Fellows will  be  led  through  the  fundamentals  of  a  web  business.   Topics include 
entering  new  markets,  gaining  distribution,  user  analytics,  pricing  and  revenue 
models.  We will also touch on insights into the female market.  As an alumna of the 
2002 CWC/Corus New Media Career Accelerator, Lally will also speak briefly on how 
the program affected her career and how she was able to make a transition from 
telecom to new media.

COFFEE BREAK
2:45pm - 3:00pm

CWC/Corus New Media Career Accelerator Workshop
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SUNDAY FEBRUARY 26 

GROUP A) 
HANDS ON LAB TIME – 
BASIC BLOG CREATION AND DIGITAL PHOTO MANIPULATION
3:00pm - 4:30pm       TransCanada PipeLines Pavilion (TCPL), Room 202

Elizabeth Vander Zaag, Media Artist

Assisted by: Susannah Gardner, Creative Director, Hop Studios, Author, Buzz 
Marketing with Blogs for Dummies; and Iwona Erskine-Kellie, BNMI Assistant and New 
Media Artist, The Banff Centre

Bring your most creative idea for a blog to this lab workshop in which you will set up 
a blog. We'll begin by talking about developing a blog strategy, and then dive straight 
into the technology. You will  receive an overview of  available blog software, walk 
through setting up a basic blog, and get familiar with using blog software to post 
entries and photos. Before you leave, you'll have your photo taken, learn to resize it 
and put it online.
 
Before you leave the session, you'll also get a chance to play with recording audio to 
post to your blog. 

GROUP B) 
SMALL GROUP MENTORING WITH FACULTY AND GUEST SPEAKERS
3:00pm - 4:30pm                   Location: See sign up sheet in TCPL Foyer

Faculty: All

GROUP B) 
HANDS ON LAB TIME – 
BASIC BLOG CREATION AND DIGITAL PHOTO MANIPULATION
4:30pm – 6:00pm                   TransCanada PipeLines Pavilion (TCPL), Room 202

Elizabeth Vander Zaag, Media Artist

Assisted by: Susannah Gardner, Creative Director, Hop Studios, Author, Buzz 
Marketing with Blogs for Dummies; and Iwona Erskine-Kellie, BNMI Assistant and New 
Media Artist, The Banff Centre

Bring your most creative idea for a blog to this lab workshop in which you will set up 
a blog. We'll begin by talking about developing a blog strategy, and then dive straight 
into the technology. You will receive an overview of available blog software, walk 
through setting up a basic blog, and get familiar with using blog software to 
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SUNDAY FEBRUARY 26 

post entries and photos. Before you leave, you'll have your photo taken, learn to 
resize it and put it online.
 
Before you leave the session, you'll also get a chance to play with recording audio to 
post to your blog.

GROUP A)
SMALL GROUP MENTORING WITH FACULTY AND GUEST SPEAKERS
4:45pm – 6:00pm                   Location: See sign up sheet in TCPL Foyer

Faculty: All

DINNER 
6:00pm – 7:00pm      Banff Centre Dining Room

ARTIST PRESENTATION
7:00pm – 8:00pm         TransCanada PipeLines Pavilion (TCPL), 201

Cheryl L’Hirondelle, Independent Interdisciplinary Artist

This  presentation  will  emphasize  Cheryl's  personal 
approach to New Media as an artist. Her background as 
a  self-trained, DIY  artist  will  add  valuable insights and 
give fellows the opportunity to hear about New Media 
from a unique and Indigenous perspective.

CWC/Corus New Media Career Accelerator Workshop
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MONDAY FEBRUARY 27

BREAKFAST 
7:00am - 9:00am                                  Banff Centre Dining Room

TECHNICAL RUN THROUGH (IF REQUIRED)
8:30am – 9:00am                 TransCanada PipeLines Pavilion (TCPL), Room 201

HIGHLIGHTS OF THE PREVIOUS DAY
9:00am - 9:30am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Elizabeth Vander Zaag, Media Artist

 
INTERNAL VS. EXTERNAL: 
MAKING THE MOST OF NEW MEDIA COMPANIES (doing it all yourself)
9:30am – 10:15am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Michel Blondeau, CEO, Ecentricarts Inc.

This talk will introduce the various team roles/responsiblilities required to fulfill a new 
media  project  and  outline  the  differences  between  in-house  development  and 
outsourcing work.

TRANSFORMING SPACE
10:15am - 11:00am       TransCanada PipeLines Pavilion (TCPL), Room 201

Jo Morrison, Creative Director, NESTA Future Labs

Digital technologies enable us to have new and varied relationships with physical 
space. Jo Morrison will discuss three projects that Futurelab has developed that give 
learners the opportunity to re-imagine space.

BREAK
11:00am – 11:15am
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MONDAY FEBRUARY 27

TEAM MANAGEMENT FROM TOP DOWN OR LATERAL APPROACH: 
PEER TO PEER TECHNOLOGIES AND COLLABORATION TOOLS
11:15am – 12:15pm                       TransCanada PipeLines Pavilion (TCPL), Room 201

Michel Blondeau, CEO, Ecentricarts Inc.

Jan Bozarth, President, Blue Arrow Music

This panel discusses and debates user driven models of interaction and design.  How 
do these new technologies enable different roles for  audiences, artists,  users and 
designers? These technologies, and user responses, have created new expectations 
for participation, validation and engagement on the part of users.  We will focus on 
participatory models and content.  Chances are that your staff will also have grown up 
in this environment. What do you need to know?  What are some of the economic and 
rights indicators to take into account in this world?  How do you use these tools to 
work with distributed teams and international networks?
  

WHAT MAKES FOR GOOD COLLABORATION? 
12:15pm – 12:45pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

Cristi Hawtin, Global Product Manager, ALIAS Systems 

Collaboration, techniques, guiding principles, business benefits.

Case Study: Alias Visualization Studio – Discovery/Concept phase, business 
requirements gathering, ALIAS collaborative software (Portfolio Wall- demonstration).

LUNCH
12:45pm – 1:45pm                    Banff Centre Dining Room

DIGITAL TOOLS FOR PERFORMANCE
1:45pm – 2:30pm                           TransCanada PipeLines Pavilion (TCPL), Room 201

Jo Morrison, Creative Director, NESTA Future Labs

Young people can create and share their own interactive multi-media artworks using 
new  and  emerging  digital  tools.  Jo  Morrison  describes  The  Jungulator,  an 
interoperable audio-visual tool for 16 - 18 year olds, and  Virtual Puppeteers, a real 
time  virtual  puppet  theatre  for  primary  school  children,  and  shows  how  their 
development with users helped to create exciting new performance tools.
MONDAY FEBRUARY 27
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BREAK
2:30pm – 2:45pm 

GROUP A) 
HANDS-ON LAB TIME:  
BLOG DESIGN AND PODCASTING 
2:45pm - 4:15pm                 TransCanada PipeLines Pavilion (TCPL), Room 202

Susannah Gardner, Creative Director, Hop Studios, Author, ‘Buzz Marketing with 
Blogs for Dummies’

Assisted by: Elizabeth Vander Zaag, Media Artist; Iwona Erskine-Kellie, BNMI 
Assistant and New Media Artist, The Banff Centre; and Jonathan Cohrs, Audio 
Admin Associate, The Banff Centre 

In  this  hands-on  workshop,  we'll  look  at  customizing  a  blog  to  your  tastes  and 
purposes, from background colors to graphics. You'll get a feel for what you can do 
yourself, and what you might need help with from a graphic designer, and you'll get a 
peek at that most challenging of HTML code:  Cascading Style Sheets.  Before you 
leave the session, you'll learn how to use an RSS newsreader, and do a little news 
aggregation on your blog as well.
 
Our final lab time will be devoted to editing a short audio recording and posting it to 
your blog. Get up to speed on the cutting-edge of blog technology: podcasting.

GROUP B) 
COFFEE BREAK/TOUR OF FACILITIES
2:45pm - 4:15pm          Meet at indoor tree, Main Level JPL

Luke Azevedo, Director of the Creative Electronic Environment, The Banff Centre,  
Maria Lantin, Research Faculty, The Banff New Media Institute; 
and Cindy Schatkoski, Program Manager, Banff New Media Institute
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MONDAY FEBRUARY 27

GROUP B) 
HANDS-ON LAB TIME:  
BLOG DESIGN AND PODCASTING 
4:15pm – 5:45pm                           TransCanada PipeLines Pavilion (TCPL), Room 201

   
Susannah Gardner, Creative Director, Hop Studios, Author, ‘Buzz Marketing with 
Blogs for Dummies’

Assisted by:  Elizabeth Vander Zaag, Media Artist; Iwona Erskine-Kellie, BNMI 
Assistant and New Media Artist, The Banff Centre; and Jonathan Cohrs, Audio 
Admin Associate, The Banff Centre 

In  this  hands-on  workshop,  we'll  look  at  customizing  a  blog  to  your  tastes  and 
purposes, from background colors to graphics. You'll get a feel for what you can do 
yourself, and what you might need help with from a graphic designer, and you'll get a 
peek at that most challenging of HTML code:  Cascading Style Sheets.  Before you 
leave the session, you'll learn how to use an RSS newsreader, and do a little news 
aggregation on your blog as well.
 
Our final lab time will be devoted to editing a short audio recording and posting it to 
your blog. Get up to speed on the cutting-edge of blog technology: podcasting.

GROUP A) 
COFFEE BREAK/TOUR OF FACILITIES
4:15pm – 5:45pm                    Meet at indoor tree, Main Level JPL

Luke Azevedo, Director of the Creative Electronic Environment, The Banff Centre 
Maria Lantin, Research Faculty, The Banff New Media Institute; 
and Cindy Schatkoski, Program Manager, Banff New Media Institute

BRANDING NEW MEDIA
5:45pm - 6:30pm       TransCanada PipeLines Pavilion (TCPL), Room 201

Lili Campbell, President & Creative Director, Footprint Strategic Communications 
Inc. 

Research is telling us that as many as 50% of consumers change their minds about a 
brand as a result of using the Internet. Is this because of the online experience on the 
brand site or is it the impact upon the brand from decentralized consumer postings on 
online forums and blogs that say more about a brand or the services it offers than the  
official site?

We will also discuss the effect of mobile technologies on the brand.
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MONDAY FEBRUARY 27

DINNER 
6:30pm – 7:30pm                       Banff Centre Dining Room

WALK TO TOWN 
7:30pm – 7:45pm

Please bring outdoor wear.  

Meet the group at the Kiln Coffee Shop.

GAMES NIGHT
7:45pm – 8:45pm                          Cyber Web Internet Café, 215 Banff Avenue

Jan Bozarth, President, Blue Arrow Music

Find out whether you are a player or not and what the pleasures and challenges of 
interactive  games  are.   We will  try  out  a  number  of  games  with  high  female 
audiences.   
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TUESDAY FEBRUARY 28 

BREAKFAST 
7:30am - 9:00am                                  Banff Centre Dining Room

TECHNICAL RUN THROUGH (IF REQUIRED)
8:30am – 9:00am                 TransCanada PipeLines Pavilion (TCPL), Room 201

HIGHLIGHTS OF THE PREVIOUS DAY
9:00am - 9:30am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Elizabeth Vander Zaag, Media Artist

RELATIONSHIP MARKETING (WITH EXERCISE)
9:30am – 10:30am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Marty Avery, Chief Catalyst, What If?  

You’ve heard “It’s not what you know it’s who you know.” This is only half true, but 
that half can make or break you. This interactive workshop focuses on how to make 
what you know more successful by creating productive relationships with the people 
you need to know. We’ll cover Who You Know, Who You Need to Know, and Best 
Practices for Getting Connected and Staying Connected with Ideal Financing Partner, 
Prospects and Influencers.

GROUP PHOTO 
10:30am - 11:15am                            Donald Cameron Amphitheatre

Please proceed to risers set up OUTDOOR in the Donald Cameron Amphitheatre, 
(across from the dining room windows)
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TUESDAY FEBRUARY 28 

BREAK 
11:15am - 11:30am

PRODUCT MANAGEMENT IN NEW MEDIA
11:30am – 12:30pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

Cristi Hawtin, Global Product Manager, ALIAS Systems

Why is ‘knowing’ your customer so important in the new media world? We’ll consider 
the Product Management lifecycle - best practices and good organizational, customer 
and team management skills - a balance between strategy and tactical.

LUNCH
12:30pm – 1:30pm           Banff Centre Dining Room

LICENSING
1:30pm - 2:00pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

Christene Hirschfeld, Partner, Boyne Clarke Barristers & Solicitors

HOW TO FINANCE NEW MEDIA
2:00pm – 3:15pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

Christene Hirschfeld, Partner, Boyne Clarke Barristers & Solicitors

Michel Blondeau, CEO, Ecentricarts Inc.

Different perspectives of  deal  making are explored,  from development through to 
marketing. What is the role of tool making in relation to the content agenda?  What 
issues are of particular importance from inside convergent media, the broadcaster, 
inside the new media company, inside the technology company?  What are the stages 
of financing, the sources in Canada and abroad? 
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TUESDAY FEBRUARY 28 

BREAK 
3:15pm - 3:30pm

THE NEW MEDIA BUDGET 
3:30pm - 4:15pm       TransCanada PipeLines Pavilion (TCPL), Room 201

Lally Rementilla, VP of Business Planning and Analysis, Lavalife Corp.

This practical session walks through all the elements of a new media budget, the 
challenges in covering the skills, time and resources needed. The usefulness of budget 
narrative. Should you budget low or high?  Smart producers have two budgets or do 
they? Monitoring your budget and costs (change control) – what are the business 
models or are there any?

PROJECTS, PERFORMANCES AND TECHNOLOGIES
4:15pm - 5:00pm       TransCanada PipeLines Pavilion (TCPL), Room 201

Cheryl L'Hirondelle, Independent Interdisciplinary Artist

How do technologies constrain what we can make? Are cultural values built into tools? 
How do these manifest? What are some ways of approaching this problem? 
Indigenous and Tribal communities worldwide still have much to offer in the way of 
innovation. This session will look at a few successful case studies worldwide, and will 
shed insight into protocols and relevant strategies and issues around access.

SKI FITTING FOR THE CROSS-COUNTRY SKI TRIP
5:00pm - 6:00pm          Sally Borden Building

Please go to the Sally Borden Information Desk and reserve your equipment for 
tomorrow’s cross-country ski trip.

DINNER
6:00pm - 7:30pm             Banff Centre Dining Room
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TUESDAY FEBRUARY 28 

IMPROVISATIONAL DRAMA 
EXERCISES THAT HELP YOU PITCH/ ROLE-PLAY PITCHING A PROJECT
7:30pm - 9:00pm              TransCanada PipeLines Pavilion (TCPL), Foyer

Colin Funk, Associate Program Director, Creativity, The Banff Centre

Fellows will be divided into teams to brainstorm a small project. In this exercise you 
will learn to more effectively engage your team members, become a better listener, 
and develop a stronger sense of self-confidence and leadership presence. Fellows will 
define roles, plan the project and look at a management structure. They will  also 
develop a design plan based on previous course work, present it to the class and 
get/give feedback.  This gives the Fellows the opportunity to role-play taking the lead 
for a team that is strongly creative and primarily technical. 
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WEDNESDAY MARCH 1

BREAKFAST 
7:00am - 9:00am                               Banff Centre Dining Room

HIGLIGHTS OF THE PREVIOUS DAY
9:00am - 9:30am                  TransCanada PipeLines Pavilion (TCPL), Room 201

Jo Morrison, Creative Director, NESTA Future Labs

PICK UP YOUR LUNCH 
9:30am – 10:00am     TransCanada PipeLines Pavilion (TCPL), Foyer

AND THEN:

PICK UP YOUR CROSS-COUNTRY SKIS - SALLY BORDEN BUILDING

MEET THE BUS FOR SKI EXPEDITION TO THE CASCADE FIRE ROAD
10:00am – 2:00pm      Out front of the Sally Borden Building

Location: Meet the bus out front of the Sally Borden Building

A brown bag lunch will be provided.
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WEDNESDAY MARCH 1

BREAK
2:15pm – 2:30pm

WORK IN GROUPS TO DEVELOP A PITCH FOR A NEW MEDIA PROJECT
2:30pm – 3:00pm                           TransCanada PipeLines Pavilion (TCPL), Room 201

Groups will develop a concept, the production, timelines, team and financing plan. 
The group will plan their pitch (including roles) to be pitched to the class on Friday. 
Led by: Marty Avery, Chief Catalyst, What If?

MENTORING SESSIONS WITH FACULTY AND GUEST SPEAKERS
3:00pm – 5:00pm                   Location: See sign up sheet in TCPL Foyer

Faculty: All available faculty and guest speakers

APRES SKI: INFORMAL EVENING WITH FACULTY AND FELLOWS 
5:00pm – 6:30pm                         TransCanada PipeLines Pavilion (TCPL) Foyer

Relax and enjoy a hot chocolate and tasty treats while sharing stories about your 
morning activities experienced so far.

DINNER AND FREE TIME
6:30pm – 7:30pm                       Banff Centre Dining Room
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THURSDAY MARCH 2

BREAKFAST 
7:00am - 9:00am                                  Banff Centre Dining Room

TECHNICAL RUN THROUGH (IF REQUIRED)
8:30am – 9:00am                 TransCanada PipeLines Pavilion (TCPL), Room 201

HIGHLIGHTS OF PREVIOUS DAY
9:00am - 9:30am                 TransCanada PipeLines Pavilion (TCPL), Room 201

Marty Avery, Chief Catalyst, What If?

ROUNTABLE DISCUSSION: POLICY AND NEW MEDIA 
9:30am – 10:30am       TransCanada PipeLines Pavilion (TCPL), Room 201

Michel Blondeau, CEO, Ecentricarts Inc.

This is an opportunity for the Fellows and Faculty to engage in discussion and debate 
about policy issues.

BREAK
10:30am – 10:45am

RESEARCH AND NEW MEDIA
10:45am - 12:00pm       TransCanada PipeLines Pavilion (TCPL), Room 201
 
Penny Jennett, Professor - Faculty of Medicine, University of Calgary

Sheelagh Carpendale, Canada Research Chair and Associate Professor Department 
of Computer Science and Faculty of Communication and Culture, University of Calgary

LUNCH
12:00pm - 1:30pm             Banff Centre Dining Room
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THURSDAY MARCH 2

PITCHING W0RKSHOP
1:30pm – 3:45pm        TransCanada PipeLines Pavilion (TCPL), Room 201

Marty Avery, Chief Catalyst, What If? 

Fellows pitch their projects to the group and receive feedback. 4 minutes for pitches 
per group with 6 minutes of discussion to follow each presentation pitch.

Each Fellow will be pitching to the group something she is passionate/knowledgeable 
about, could give to others, and would like to get from others, express her needs. 
Then  instead  of  feedback  on  the  pitch,  the  people  in  the  room  can  contribute 
connections and ideas. 

This session will be voice recorded and shared/circulated afterwards.

BREAK
3:45pm – 4:00pm

PROGRAM EVALUATION: FACULTY
4:00pm – 5:00pm                 TransCanada PipeLines Pavilion (TCPL), Room 201

PROGRAM EVALUATION: FELLOWS 
5:00pm - 6:00pm         TransCanada PipeLine Pavilion (TCPL), room 107

Emily Paige, BNMI Coordinator, The Banff New Media Institute

RECEPTION AND BANQUET DINNER
6:30pm - 9:30pm                   FUZE, 2nd Floor, 110 Banff Avenue, Clock Tower Village 
 
Join  Faculty, Staff  and Fellows for  a  final  farewell  dinner  at  one of  Banff’s finest 
restaurants.

One taste and you'll know why they use the word finer to describe 
the  dining  experience  at  Fuze.  Their  award-winning Chef  has 
literally traveled the globe to bring you the best the world has to 
offer.  From  traditional  French,  to  the  flavours,  spices  and 
ingredients  of  India,  Asia,  Canada and elsewhere,  the  food at 
Fuze is truly a worldly experience.

"2005 Best New Restaurant in the Canadian Rockies" - WHERE Magazine 
"Canada's Top 100 Wine Savvy Restaurants" - Wine Access Magazine 
"Canada's Best New Dining Trends 2005" - enRoute
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FRIDAY MARCH 3 

BREAKFAST 
7:00am - 9:00am                                  Banff Centre Dining Room

TRAVEL DAY FOR FACULTY AND FELLOWS
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INDIVIDUAL BIOGRAPHIES

FELLOWS

Sarah Anson-Cartwright

Sarah calls herself a “policy wonk” in a converged world. Over a year ago, she joined Bell 
Canada as Director of Government Relations in Ottawa, where she tackles public policy 
issues in the Internet, telecom, mobile and broadcasting milieus.

When it  comes to new media, Sarah was fortunate to have managed one of the first 
private-sector  funds,  the  Stentor  New Media  Fund  launched  in  1997.  Previously, she 
helped shape one of the first public-sector funds for new media production, while at the 
Ontario Film Development Corporation in the mid-1990s. 

Sarah’s career includes experience in public  policy development, government relations 
and advocacy, as well as magazine editing, writing and publishing. Her subject matter 
expertise covers telecom, broadcasting, film and TV production, Internet, new media and 
convergence.

Sarah has had the great opportunity to attend the Banff Centre twice in the past twenty-
odd years. First, she came for the Banff Publishing Workshop. Then she returned for the 
Arts Administration Program. She is delighted and excited about being immersed in the 
New Media experience very soon at Banff!

Sarah is married to William, a theatre guy, and they have twin 7-year-old daughters, 
Caroline and Rosalind. Sarah lived in Toronto until 10 years ago, but really loves life in 
Ottawa. She is a board member of Third Wall Theatre and is training to run her second 
marathon in the spring.

Ann Barnes

Ann  is  currently  acting  as  General  Counsel,  VP  Business  Affairs  at  the  independent 
broadcaster Insight Sports Ltd. She provides legal and business advice for ISL’s three new 
channels  (GOLtv  (soccer),  CGTV  (casino-gaming),  and  WFN(fishing))  for  distribution 
arrangements, emerging new media markets, and corporate and commercial matters. 

She worked for two other broadcasters: Alliance Atlantis Broadcasting Inc.
as Vice-President, Business & Legal Affairs;  and, NetStar Communications Inc as In-
house counsel.  In both positions, she was responsible for all legal matters relating to 
distribution: interactive technology, IT, finance, and sales and marketing. She was also 
responsible for all New Media projects and Intellectual Property matters.

She gained corporate in-house experience while employed with  Cott Corporation (private 
label water and soda manufacturer) and Manulife Financial as Associate Counsel. In these 
positions  she  was  involved  in  the  structuring  and  negotiation  of  various  mergers, 
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acquisitions  and  refinancings.  She  worked  closely  with  Senior  Management  and  the 
various business units to draft, review and negotiate various business and legal issues 
including:  corporate,  securities,  commercial,  information  technology  and  employment 
matters. 

Outside of family life, Ann’s interests include painting, boxing, golf, and jogging. She is 
currently an active Board Member of the “Friends of the Frost”, a charitable organization 
developed to facilitate and support environmental education for children and the David 
Suzuki Foundation. She is mother of a very active 2 ½ year old son, has a wonderful 
husband and a high-maintenance dog named ‘mo-mo’.

Lisa Bowditch

Lisa has been fascinated by the broadcast industry since her childhood.  Her father was a 
Canadian broadcast engineering pioneer and she grew up visiting urban production plants 
and isolated transmitter sites.  Her first part-time job was in the newsroom at a local 
Toronto television station.  This grew into a full time job in their News Library.  Within a 
few years, Lisa had moved on to CTV National News Research & Archives where she spent 
the next 10 years as their Senior News Archivist.  

In 1998, Lisa made the big move from News to Sports.  CTV was starting a new sports 
specialty channel and she was recruited to develop a sports archive for the new network. 
Seven years later she is still  managing the Sportsnet Library, which has evolved into 
80,000+ hours of sports programming and highlight footage. 

Lisa’s family connection to the broadcast industry has continued through marriage.  Her 
husband is the Canadian Sales Manager for a leading Canadian production equipment 
manufacturer.  The associations of her family and their varied experiences have given her 
an extremely broad view of the industry in which she works and a unique perspective on 
its future.

Lisa lives in a small town northeast of Toronto and is mom to three very active young 
boys – aged 5, 10 and 12.   Her favorite pastimes include watching her boys play hockey, 
lacrosse  and soccer, and  cheering  from the  slopes  as  they  race alpine  skiing.    Her 
personal hobbies are downhill skiing, hiking, and running.  
    

Pamela Chan

Pamela Chan has been working in Canada's Web industry for over eight years, which 
means she has experienced her share of Web booms  and busts.  Her early experience 
ranges  from  musical  (TheyMightBeGiants.com)  to  money  (RBC.com)  to  medical 
(Viagra.ca, Lung.ca), working at various web production houses. She has also worked in, 
and continues to dabble in freelancing. 

Currently, Pamela is the sole producer for the online destination of  Maclean's, Canada's 
top news magazine. She is currently expanding the multimedia and interactive content of 
the site,  while still  maintaining daily news updates.   In her time there,  she has also 
doubled the site’s traffic, which now receives several million visits a month.
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Prior  to Macleans.ca,  Pamela worked for  another successful  Canadian publication: the 
website for number one women’s magazine Chatelaine. Starting as their very first Online 
Editor, she grew to become Web Production Manager, overseeing an ever-expanding staff 
and several, several redesigns.

Pamela received her degree in Fine Arts Cultural Studies from York University, specializing 
in Multimedia with a minor in Psychology. Who says a Liberal Arts degree doesn't pay off?

When she isn’t parked in front of her computer, Pamela likes to cook and practice yoga. 
She is also a card-carrying member of the Origami Society of Toronto and is eagerly 
anticipating the 2006 World Cup.  She lives near Toronto’s Harbourfront with two cats and 
her partner Oliver.

Terry Dinsmore

Just about 30 years ago, Terry started out as an advertising agency media planner and 
buyer and spent years working for large agencies such as McKim Advertising in Toronto 
and later for BBDO in Vancouver.  She also ran her own media consulting company for 2 
years.  Later, at Grey Advertising she served as Media Director and Co-manager. 

She opened the Vancouver office and was the BBM's Director of Client Services for 
Western Canada for 9 years. Next was CKWX 1130 radio, where Terry was the top billing 
senior account executive for six years. 

Currently Terry is the President of Dinsmore Media and works as a media consultant to 
various  direct  accounts  and  numerous  agencies.   In  addition  to  media  buying  and 
planning, she does media research for radio and community newspapers and works with 
new forms of media developing their sales tools and presentation material.  Terry has 
over  5  years  experience  as  an  instructor  in  media  at  BCIT  in  their  Marketing 
Communications program.

Terry is active in the local advertising community and currently serves as Chair of BCIT's 
Marketing  Communications  Advisory  Council.  Terry  has  also  served  with  other 
committees;  Make-A-Wish Foundation,  NAB, Muscular, CWC -3  years on  local  chapter 
board for BC and 3 years on national board. She is the Winner of Audrey Bothamley 1999 
AWARD for contribution to the media industry.

In her spare time, Terry loves to travel, paint, golf and go for long walks on the beach 
with her best buddy, Wags.

Sylvia Henry

I was born and raised in a small town outside of London, Ontario.   When I turned 18, I 
was off  to the University of Waterloo to get my degree in Bachelor of Math/Business 
Administration, Information Systems.  In my first  year of  university, I  was given the 
opportunity to start a part time job at Bell Canada.  

Now I am going into my 20th year at Bell Canada – it has been a very interesting path.  
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I  started  my career  at  Bell  as  an  associate  in  the  Plant  department  responsible  for 
activating phone lines.   Throughout  the  next  several years  I  quickly  shifted  into  the 
System and Technology starting as a Business Analyst and then moving into a Solutions 
Prime position.   In this role, I was responsible for delivering several multi million dollar 
projects.  This required traveling extensively throughout Canada and parts of the US, 
while  acting as  a  key liaison  between the  project  team and vendors such as  Lucent 
Technologies, CGI and IBM. In addition, I was involved in consolidating various business 
unit specific requirements to form a holistic solution.

Recently, I changed positions to become the program manager for the Consumer Wireline 
business.   My prime accountabilities are cost  reduction for  all  Call  Centers  and Field 
Operations by establishing and measuring Key Performance Indicators.  

I  am also a wife and a mother of two beautiful  little girls  (Alyssa 2 and Katrina 4), 
currently residing in Ancaster, Ontario.   In my spare time, I  do various recreational 
activities with my girls.  I also participate in various fundraising for efforts.   

Julie Henson

For the past 13 years, Julie Henson has been a driving force at Rogers Television.  

After graduating from Ryerson University, Julie worked as a broadcast journalist in radio 
before starting her career as a Publicity Officer at Rogers Television in Ottawa.  In 1994, 
Julie took a year-long sabbatical from Rogers to serve as the National Community Channel 
Coordinator at the Canadian Cable Television Association (CCTA).  Upon her return to 
Rogers, Julie was given progressive assignments and in 1997, she moved to Toronto, 
where in 1999, she was appointed Promotions Manager.  Her responsibilities  included 
overseeing advertising, public, media and community relations and the development of 
the station’s brand.  Julie provided leadership in all these areas in order to position Rogers 
Television as an important differentiator for the cable company.  

A key member of the team responsible for the transformation of Rogers Television over 
the past decade, Julie’s work has been widely recognized within the industry.  In 2002, 
Rogers Television’s “Local Matters” image campaign received the CCTA’s Galaxi Award for 
Best Overall Promotion and in 2005, the station’s new on-air rebrand earned prestigious 
Promax/BDA Gold as the Branding/Image Campaign of the Year for Cable and Satellite 
Systems. 

In  October  2005,  Julie  was  promoted  to  Director, Creative  Services,  Planning  and 
Development for Rogers Television’s group of 31 local stations. 

Julie and her husband William now live in Ottawa.
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Colette Johnson-Vosberg 

I served as CWC GTA Treasurer for 2.5 years and in January '06 moved into the role of 
Co-Chair person.  I have been in the broadcast industry with Global Television overseeing 
Canadian contracts for  the past  4.5  years  but  looking for  new challenges,  moved to 
Alliance Atlantis in the Motion Picture Distribution dept.  I'm still involved in contracts but 
also deal with sales of PPV, VOD, PAY TV and Free TV.  Future goals are to develop my 
skills further in sales and exploiting new media opportunities.

Anne Liota

Anne Liota’s career in the dynamic world of Media started at M2 Universal and Young & 
Rubicam working on high profile automotive and beer accounts.  From there she shifted 
her talents to AllianceAtlantis where she became an integral part of the Sales Promotions 
team.  Here she honed her creative skills to develop exciting promotional concepts from 
paper  to  live  on-air.  At  this  point,  Anne  joined  CTV  Customer  Marketing  Group  to 
integrate her ideas through promotions and station produced programming. Utilizing her 
past experiences to her success at CTV, it was only within a year that Anne was promoted 
to Customer Marketing Manager on the Comedy Network.    

Anne Liota is now at Rogers Sportsnet and was recently promoted to the newly formed 
position of Director, Marketing Solutions for Rogers Sportsnet. In this role Anne manages 
a team of three people, including a Marketing Representative, a Producer and a Team 
Coordinator.  She has quickly established a reputation as an industry leader at creating 
innovative, custom communications solutions for Sportsnet’s customers.

Anne works with many of Canada’s leading advertisers at both the agency and client-
direct level, building custom programs and communications solutions tailored specifically 
for  them.   This  includes  sponsorships,  sponsored  features,  consumer/viewer  TV 
promotions,  in-store/point  of  sale  promotions,  creating  vignettes,  creating  online 
sponsorships, online contests, online fantasy pools, wireless video delivery sponsorships, 
SMS-driven promotions, and SMS on-screen text sponsorships.   Frequently it involves 
integrating many of the above tools into one idea in response to a client briefing.  Anne 
also works cross-media, working to bundle Sportsnet with other Rogers Media assets, 
including Sportsnet Magazine, the Toronto Blue Jays, Rogers Centre, Rogers radio, and 
Rogers publishing.

Ann Mainville-Neeson 

Ann Mainville-Neeson is  Senior  Regulatory Legal  Counsel,  Broadband Policy at  TELUS 
Communications Inc.  Prior to that, Ms. Mainville-Neeson has served as Executive Director 
of the Canadian Broadcast Standards Council (CBSC), a self-regulatory organization which 
deals with programming content on Canadian private radio and television stations and 
specialty services.  A trilingual lawyer (Danish being her third language), Ann also teaches 
Communications Law (Droit des communications) at the University of Ottawa, Faculty of 
Law.  A strong believer in giving back to her community, Ann is involved with many 
charities and women's groups.  In addition to being a member of CWC, Ann is Chair of the 
Ottawa Chapter of the CATA/Women in Technology (WIT) Forum.  Ann also sits on the 
Board of Directors of MASC, an organization which brings arts to youth in schools and in 
the community and is a special advisor to the Board of iSisters, an organization which 
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seeks to empower disadvantaged women with technology.  Prior to that, Ann was involved 
with Big Sisters Big Brothers Ottawa for over 12 years.

She is a former Big Sister and has served as President of Big Sisters of Ottawa-Carleton 
and as the first President of Big Sisters Big Brothers Ottawa following the amalgamation 
of the two "Big" agencies in Ottawa, an undertaking which she led.  Ann has also been 
active with the Rotary Club of Ottawa and United Way/Centraide in Ottawa.  She is the 
recipient  of numerous awards and recognitions, including a Community Builder Award 
from United Way/Centraide in 2000.

Natalie McGee

Natalie McGee (nat'a'le me'ge) <Consulting Analyst> adj. a spirited architect for change; 
analytically creative; decisive; organized n. extravert; thinker; an advocate for simplicity 
* Natalie arrived at TELUS from Toyota Motor Manufacturing Canada where she honed her 
skills in championing "customer-first" ideology. * She is an enterprising and accomplished 
problem-solver, fit  to  communicate  and  organize  information  into  well-conceived  and 
highly consumable bits. * Motivated to see possibilities and understand complexities when 
designing  useful  solutions  to  problems,  she  is  hands-on,  resourceful,  adaptive  and 
stylistically skilled. * Natalie is a Professional Engineer (P.Eng.), and holds an additional 
technical  diploma  in  Applied  Information  Technology  from  Information  Technology 
Institute.

Lisa McPhail

Lisa is presently a Business Development Officer in Industry Canada’s Information and 
Communications  Technology Branch.  Her  focus  has  been  on  Canada’s  e-industries  - 
working on programs and policies  for  industry strengthening and export  development 
strategies - with a particular focus on e-Learning and e-health.  

Lisa  began  her  career  as  a  librarian,  setting  up  and  establishing  the  first  fully 
computerized information and research center in the Canadian Federal Library System for 
the Canadian International Trade Tribunal (CITT) in 1988, then taking positions as Chief 
Librarian at Investment Canada, and the Canadian Intellectual Property Office (CIPO). In 
1995  Lisa  joined  Canada’s  SchoolNet  initiative,  and  worked  with  SchoolNet  National 
Advisory Board committees to develop engagement strategies targeted to help Canada 
become the most connected country in the world.

Lisa was recently selected for the CWC Jeanne Sauve Career Development Program. Her 
assignment was with the Rogers family of companies in Toronto.  She is presently on an 
assignment  with  Human Resources Development  Canada  working  with  the  Workplace 
Skills Initiative to foster innovative models to increase the productivity and investment in 
Canadian workplaces.  As always, her focus is on strengthening the relationship between 
the  federal  government  and  the  Canadian  private  industry, and  ensuring  access  to 
information and technology for all Canadians.

Lisa has 12 year-old daughters (twins!) and lives with her husband Alex in Ottawa.

Jackie Pardy
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Jackie Pardy is the Director of Program Acquisitions and Contract Administration for Corus 
Entertainment,  Children’s Television division.  Her responsibilities  include assessing and 
negotiating program acquisitions, managing program inventories and budgets for all three 
of Corus children’s networks: YTV, Treehouse TV and Discovery Kids.

Jackie  graduated  from  University  of  Toronto where  she  studied  Sociology  and  Film. 
Extensive experience in the television and film industry led Jackie to Corus, where she has 
been for the past eleven years. Working in Children’s television has been a good fit for 
Jackie, a mother of three, whose children are affectionately referred to as her personal 
focus group. Jackie and her husband, David, live in Toronto with their three daughters, 
Erin, Samantha and Lauren. 

Margot Patterson

Margot Patterson is Senior Legal Counsel with the Canadian Association of Broadcasters. 
She has been counsel to the CAB since 2000, following completion of her articles at the 
Legal Directorate of the Canadian Radio-television and Telecommunications Commission. 
She was called to the bar in 2000 and is a member of the Law Society of Upper Canada. 
She holds a law degree from McGill  University, and a Masters of Public Administration 
from Queens University.  Margot has a two-year old daughter and a 6-month old son.

Lori Rosenberg

Lori Rosenberg has been a member of the television industry for fifteen years, in the 
production,  distribution  and  funding  of  content,  and  in  the  programming,  promotion, 
general management and distribution of conventional and specialty networks.  In that 
time, she has participated in the launch of analog and specialty services, re-branding of a 
conventional television network, and has acquired programming up to a budget of $100M. 
Her experience spans five major Canadian media and/or telecommunications companies 
and a not-for-profit cultural funding agency.

Janine Salvas

Janine Salvas has been a member of the television industry for 11 years. She started her 
career with CTV in the Traffic department and after 2 years, expanded into Programming, 
and for the past few years, expanded into CRTC compliance and program obligations. She 
currently manages a large group of conventional and specialty networks for CTV, and her 
role  encompasses  various  areas  of  the  company  including  Sales,  Traffic, Operations, 
Promotions, Marketing and Regulatory to ensure CRTC compliance.  She has participated 
in the launch of analog, specialty, and HD services, as well  as in the development of 
business process, system development and implementation.

Janine is a recipient of 2002 Bell Globemedia Ovation Award for Outstanding Performance. 
Recently she was promoted to Director of Program Obligations, for all CTV Conventional 
and Specialty services.

Valerie Sepulveda

Valerie has been with Corus Entertainment in the Content Distribution, Affiliate Relations 
department for  2  years.  During her  time at  Corus,  she began managing accounts  in 
Eastern Canada from Toronto, and has since moved to Calgary, AB to manage Western 
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Canada  and  Corus'  premium service,  Movie  Central.  Her  accounts  have included  the 
largest cable and satellite companies in Canada including Rogers, Cogeco, Shaw, Star 
Choice and Bell ExpressVu.

Expanding to New Media has been a regular part of her department's objectives in the last 
year. She was part of the team to first to launch Video on Demand in Canada with Movie 
Central  and  Treehouse. Corus  has  been  striving  to  distribute  Corus  content  in  new 
mediums and all possible platforms. To date, they have launched YTV and Treehouse On 
Demand  in  most  major  cable  companies  in  Canada,  including  an  exclusive  YTV  On 
Demand launch on Comcast, the largest cable operator in the US, and have also launched 
this  content  on  wireless  hand  held  phones  in  Canada.  Corus  continues  to  seek  new 
platforms in which to expand their content with their partners in North America.

Before Valerie started at Corus Entertainment, she completed her MBA at the Haskayne 
School of Business in Calgary with a focus on Strategic Management. This West Coast 
native received her Bachelor of Arts degree from the University of British Columbia in 
Psychology. She  currently  resides  in  Calgary, AB  and  enjoys  the  proximity  of  the 
mountains which allow her to lead an active lifestyle all year around.

Donna Whitney

Professionally, I  am  a  Director  of  New  Business  Implementation  in  the  Engineering 
department for Rogers Communications. My overall professional aspiration is to love what 
I do, face continual challenge in my role, grow as a person and as a professional, and 
contribute positively to society and those around me. My specific professional aspiration in 
the broadcasting industry is to influence the platform and delivery of broadcasting by 
assisting the industry to incorporate new technologies. I want to help integrate and adapt 
the  way  that  content,  communication  and  technology  are  married,  and  play  an 
instrumental role in the new and exciting ways that both can be utilized.

Success to me is defined on many levels; emotional, physical, financial and spiritual. I 
strive  to  find  balance  between  all  these  aspects  of  my life.  I  place  a  great  deal  of 
importance on performing a role that is fulfilling and meaningful in order to ensure this 
balance is met. Success is fulfilling a career around work that is worth doing, work that 
has value and positively impacts the lives of others. I strive to evolve my career into a 
position that shapes the future of technologies and communications. 

On the personal side of things, I am married with two dogs and three ferrets. My children 
include; Nikita a 6 year old Husky, Odessa a 2 year old Lusky (Lab-husky cross), Cheeks a 
100+ year old ferret (ok, she’s 10), Peanut and Cha-hoo-hoo both ferrets and both 5. Just 
for the record, I did not name the animals; I blame my husband for that. My husband and 
I live in Newmarket, Ontario, a small suburb very north of Toronto. I, like so very many 
others, commute to Toronto every day.  

I am originally from Winnipeg, Manitoba and moved to Ontario in 2000 when my husband 
was hired by the Toronto Police. Both of our families are still in the Peg. Since our move 
my husband has  changed forces  to  York Region (just  north  of  Toronto). My  hobbies 
include; bodybuilding, computers, target practice, music, and food (not cooking it, just 
eating).

I  am looking forward to  learning about new media  and all  of  the fascinating women 
selected for this course. 
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Lisa Woznica

Lisa  is  a  Manager  with  SECOR Consulting  in  their  Toronto office.  In  her  eight  years’ 
experience in strategy consulting, she has worked with many Canadian corporations in the 
areas  of  strategic  planning  &  analysis,  option  development  &  evaluation,  project 
management, financial modeling and analytical problem solving.  She has consulted in a 
variety of industry areas such as telecommunications & media, financial services, retail, 
and public sector. This work includes:

 Completion of a feasibility study on the efficacy of a shared digital content delivery 
system model for the Canadian publishing industry: developed four alternate delivery 
models and developed specific  strategic, technical  and economic evaluation criteria 
and business case

 Development of a high-level analysis of the Canadian visual effects market: performed 
industry and competitive scan for feature film & television production; identified key 
variables that drive success in VFX; evaluated client along those variables; developed 
and evaluated growth strategy options

 Articulation  of  a  process  for  creating an e-Health  strategy in  regional  health  care 
organizations: outlined strategic context for e-Health in Ontario and developed key 
recommendations to enable regional e-Health planning

 Research and publishing of articles in the areas of: merger & acquisition effectiveness; 
the  restructuring of the insurance industry; and the changing customer marketplace 
and its impact on customer-facing businesses

Lisa has been a member of CWC since 1999, on the Steering Committee of the GTA 
Chapter  since  2003  and  the  Committee  Co-Chair  for  the  last  two  years.   She  has 
participated in the development of a number of local CWC events including the Breakfast 
Series and the Power Circle mentorship evenings.

Lisa holds a BA in History from Harvard University and an MBA from the Richard Ivey 
School of Business at the University of Western Ontario.

Karen Zuke

Shortly  after  graduating from High School,  Karen Zuke began her  media  career  with 
Golden West Radio in the Creative Writing department in Steinbach, Manitoba.   For the 
next  4  years  Karen  used  her  creativity  and  knowledge  gained  at  the  University  of 
Winnipeg to develop effective radio marketing concepts for Golden West clients. She had 
numerous scripts selected for industry publications including Radio Ink Magazine!   

Karen was promoted to Golden West Broadcasting's Head Office to assume the role of 
Creative Supervisor.   Karen's inherent knowledge of Golden West's creative system was 
key to her leading the company from the paper script era to the implementation of a fully 
digital creative process.

After a couple years, Karen shifted her focus to Radio Broadcast Sales by joining   the Co-
op Sales and Promotions Department at Golden West's, Head Office; this role introduced 
Karen to internet research, internet promotions, digital design, desktop publishing and 
logo development.  Her passion for computers and the internet was flourishing.
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As  the  21st  century  arrived,  Golden  West Radio introduced  a  new online  division  to 
complement   their expanding radio business.  Karen embraced the opportunity to assume 
the newly created position of Web Projects Coordinator; Karen was responsible for the 
design and technical  development of  6 community portals,  web advertising and client 
websites.

In  July  2005,  Karen  was  appointed  Web Services  Manager  for  Golden  West Online; 
managing online advertising sales and is developing an aggressive growth strategy for the 
company with the proposed launch of ten community web portals across Western Canada.

Karen has volunteered her design skills to many community groups by developing logos 
for a number of organizations. 

She was also the winner of a community logo design award from the City of Portage la 
Prairie.

In her spare time, Karen enjoys traveling, home decorating, gardening and spending time 
with her family. 
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INDIVIDUAL BIOGRAPHIES

FACULTY & GUEST SPEAKERS 

Luke Azevedo

Currently Luke is the director of the Creative Electronic Environment at The Banff Centre. 
Over the past 20 years in the broadcast industry, he has advanced the new media and 
technology fields in Western Canada. He was involved in the implementation of one of 
North America's first DVD authoring and encoding systems. Luke worked as the broadcast 
liaison for the Calgary Flames Hockey Department for many years. He was a television 
and  video  consultant  to  the  Canadian  Hockey  Association  through  eight  world 
championships (male/female/junior) and five Olympic Games. In addition he was the 18-
year owner/operator of Western Canada's most technically advanced transfer, duplication, 
authoring  and  encoding  facility  as  well  as  vice-president  operations  of  Nova 
Entertainment, North America's largest distributor of alternative programming. In 1989, 
Luke  was  part  of  an  Emmy award-winning production  team that  produced  children’s 
programming in Los Angeles. 

In the three years Luke has been at The Banff Centre he has led a team that designed 
and implemented two Advanced Research and Technology (ART) Labs. The first is a 3D 
immersive  environment,  PC-based  facility.  The  second  is  a  collaboration  lab  which 
integrates existing video conferencing and Access Grid research network technology. In 
2003, Luke had a paper published on the production of content for web streaming. 

During the last six months Luke has led the The Banff Centre in to the next frontier of 
Video  with  the  acquisition  and  implementation  of  HDTV  (High  Definition  Television) 
acquisition and HD edit technology. 

Marty Avery 

Marty Avery is Chief Catalyst and founder of What If?, a business development strategy 
company based in  Calgary that  helps  leading,  bleeding-edge and hard to  understand 
companies connect with the people they need to know in a meaningful way. 

Over the last 20 years, Marty has researched, created and implemented merchandise, 
brand  and  sales  strategies  for  a  diverse  group  of  businesses.  Folks  like  Roots,  The 
Framing and Arts Centres, Cornell Trading, Apple, Ivanhoe Cambridge, Sunlife Financial 
Real Estate, and McMillan Binch have benefited from Marty’s expertise. Marty generates 
fruitful  “conversations” with  an organization’s customers  and  facilitates  their  business 
development. She honed her interview skills while a morning show host for CBC Radio. An 
early adopter of the web, she introduced it to CBC in 1986 and has been involved with the 
strategy and design of 34 websites, and holds the honour of e-commerce enabling the 
first North American shopping centre in the early ‘90s.

Among her growing list of client collaborations are The Body Shop, Second Cup, Sklar 
Peppler, Miller  Thomson, I.C.S. International,  McMillan Binch, Kids and Company, CBC 
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Radio,  Atlantic  Women  Business  Owners,  Whetstone,  Chicken  Soup  for  the  Beauty 
Professionals Soul, and over a dozen technology-based start-ups.

She’s participated in the Prime Minister’s Task Force for Women in Business. Marty has 
been a guest lecturer at the Women Presidents Organization Annual Conference (Leading 
from Within), New Brunswick College of Craft and Design (Business Building), Ryerson 
University (Communications and PR), the Banff New Media Institute’s Interactive Projects 
Lab  (Pitching and Relationship Building)  and the  Canadian Film Centre’s Habitat  New 
Media Lab (Networking and Pitching). She also advised MBA students on marketing and 
sales  through  the  University  of  Toronto’s Rotman School  of  Management  Integrative 
Challenge, a competitive business simulation that teaches students to think like general 
managers in a real-world environment.

She has received one North American and six national marketing awards and is a member 
of the American Marketing Association, the Professional Services Marketing Association, 
and a founding member of the Women Presidents’ Organization (WPO) Toronto Chapter II. 
As a current Director on the board of Future Possibilities, she is heading an initiative to re-
brand the not-for-profit while building a consistent communications platform. Marty was 
recently a panelist on the World Summit  Awards’ Canadian competition jury, a global 
contest for selecting and promoting the World’s best e-contents and applications Marty is 
schooled in design and the arts having studied Architecture at the University of Waterloo, 
Fashion Design  at  Sheridan  College,  and  a  B.A.  in  Literature and  Psychology  at  the 
University of New Brunswick. Marty prides herself in helping businesses to connect with 
the right people in a way that is rewarding and profitable to them.

Ed Bamiling

Ed is  currently  the Ceramics Facilitator with the Visual  Arts Department at The Banff 
Centre for the Arts.  He is responsible for all aspects of the ceramic studio operation as 
well as consulting with and advising resident artists on the successful resolution of their 
projects.

As a practising artist for more than twenty-five years, Ed has exhibited widely in solo and 
group  exhibitions,  nationally  and  internationally, including  the  United  States,  Mexico, 
Japan,  France,  England,  Germany, Greece,  Taiwan and  Korea.  He  has  lectured  and 
conducted workshops in Canada, the U.S., Mexico, Greece and Korea.   

Ed has also been affiliated with the Leadership Development area at the Banff Centre as a 
facilitator  and  faculty  member  for  ten  years,  guiding  creativity  sessions  with  many 
programs in both public and customized areas of leadership.
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Deborah Beatty

Deborah is currently the VP & GM of Corus Radio Interactive, a group within the radio 
division of Corus Entertainment.  Corus is a leading Canadian media company that was 
spun out of Shaw Communications in September of 1999. With Corus Radio Interactive 
Deborah is  focused on growing Radio's Interactive business, including running Radio's 
Interactive  sales  efforts.   Deborah  joined  Corus  in  1999  as  Director  of  Business 
Development,  reporting to the CEO. In 2001,  she was promoted to run all  of  Corus' 
Interactive properties. In 2005, she moved into the Radio group to help capitalize on the 
rapid growth in the Interactive area within that division. 

Prior to Corus, Deborah worked for Monitor Company, a leading strategy consulting firm in 
Boston, New York and London, England.  Deborah has a MBA from INSEAD and a BA from 
Princeton University.

Michel Blondeau 

Michel Blondeau has been directing and developing New Media productions since 1995. 
Over time he has produced a wide range of interactive projects that have broken new 
ground in the convergence landscape and garnered much recognition by peers and public, 
alike. 

In February of 2000 Michel founded ecentricarts inc. (www.ecentricarts.com), a service 
and content development company with a focus in entertainment, culture and education. 
In a short time, the company developed a reputation for producing all-round high quality 
work. In 2003 ecentricarts inc. won a United Nations World Summit Award for Excellence 
in  Digital  Culture.  In  2004,  he  received  the  Global  Television  Network  Broadcast 
Communications Award for his contributions to the New Media industry.

Michelle Bohning

After completing a BA in philosophy/history at the University of Alberta, Michelle moved to 
Seattle,  WA to  study  music  at  Cornish  College  of  the  Arts.  Cornish,  where  in  1938 
revolutionary composer John Cage created his first prepared piano, promised an enticing 
environment for artistic convergence. Michelle studied with free jazz vocalist Jay Clayton 
and graduated with a BFA in performance. After Cornish, Michelle returned to Alberta, 
joining The Banff Centre’s Theatre Arts department and refining her skills in mountain 
biking, whitewater kayaking, skiing and other outdoor pursuits. Her interest in new media 
grew  while  working  as  associate  producer  with  the  Banff  World  Television Festival. 
Returning to  The  Banff  Centre  as  line  producer  for  the  BNMI’s Accelerator  program, 
Michelle is excited to use her energy to support Western Canada’s new media innovators 
as they define our daily lives, as well as our futures.
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Jan Bozarth                                                                                

Jan Bozarth is a pioneer in entertainment, specializing in the creation of highly honored 
and  nationally  acclaimed  entertainment  products  for  thirty  years.   Jan’s early  career 
spanned  twenty  years,  specializing  in  music,  home  video,  family  and  children’s 
programming through her tenure with CBS-FOX, MCA, Warner-Elektra-Atlantic, Esquire 
Magazine, and others.  As an independent creator of family and children’s programming, 
she has developed, guided, designed, or produced more than 14 home video programs, 3 
original stage musicals, 12 CD-ROM games and 4 original music CD’s. Additionally Jan is a 
composer who works with her family of composers that has produced songs, musicals and 
scores for games, television, ads, and other media. Jan is also nationally recognized as a 
branding expert for positive content for children and family programs.

In  1996 Jan became the  Vice  President  of  Creative for  Girl  Games,  Inc., one of  the 
interactive industry’s first girls-focused companies, followed by her leading design and 
productions for Mattel.  Jan’s innovative and ground-breaking work with hit titles over the 
past nine years include:  Let’s Talk About Me™, Viacom and Mattel products’  Sabrina™ 
and Clueless ™ (both based on hit television series), Barbie® Designer Series, Barbie® 
Gotta Groove,  and Diva Starz™  and most recently  Bratz®,  Atomic Betty™ and more. 
Jan’s vision of creating product that appeals to, and shifts with, the consumers’ lifestyle 
interest and sensibilities during each facet of her career has been recognized through 
many Industry Awards.

In 2005 Jan created a new brand for preteen girls, The Fairy Godmother Academy™.  She 
will head the ongoing development of the brand and will serve as President of Her Light 
LLC which will produce a series of six books, a feature film, and games based on the 
brand over the next two years. Jan remains the President and founder of Blue Arrow 
Media Inc., which creates music, media designs, interactive media toys and games for top 
toy designers and software developers for a variety of clients across North America.  

Lili Campbell

Lili is President and Creative Director of Footprint Strategic Communications, a branding, 
design and strategic communications consultancy specializing in corporate and marketing 
communications.  Prior  to  establishing  Footprint,  Lili  was  Vice-President  of  CREDO 
Communications, which she built over a two-year period into a vital niche branding and 
design consultancy that was then absorbed by the parent firm. Having worked with clients 
like Rio Algom Limited, TD Bank, Bell Canada, Canbras, and Atlantis Communications, her 
work has been recognized with a number of creative awards for excellence here in Canada 
and abroad.

In addition, she has more than 15 years of experience with leading international design 
and communications consulting firms and has directed major communications initiatives, 
including corporate identity and branding projects,  annual  reports and interactive and 
print  campaigns,  for  a  wide  variety  of  companies  in  the  financial  services, 
telecommunications, natural resources, and entertainment sectors. Lili has also been a 
strategist and communications consultant in the public relations field, working primarily 
with clients in the high-tech sector. She worked in the financial services sector for 10 
years before becoming a creative professional. 
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Lili has spoken at international conferences on branding and was invited to speak in Hong 
Kong to the American Chamber of Commerce, concerning the city’s new brand. Active in 
the community, Lili has sat on the Board of Gems of Hope, a charity that promotes micro-
enterprise  programs in  the  developing  world,  and  on  the  Board  of  The  International 
Alliance for Women (TIAW). She has consulted for the Offord Centre for Child Studies at 
McMaster University having established their new name and brand. 

Under her direction, Footprint continues to serve clients in both the profit and not-for-
profit sector, striving for creative excellence in developing brands that are memorable and 
enduring.

Sheelagh Carpendale

Dr. Sheelagh Carpendale holds a Canada Research Chair in Information Visualization and 
is an Associate Professor of at the University of Calgary. She holds her Chair jointly in the 
Department of Computer Science, Faculty of Science and the Faculty of Communications 
and Culture. She is the recipient of several major awards including Canada Foundation for 
Innovation Awards, the  Natural  Sciences  and Engineering  Research Council  University 
Faculty Award, the British Academy of Film and Television Arts Award for Off-line Learning 
as well as academic and industrial grants from Natural Sciences and Engineering Research 
Council, Intel Inc., and Forest Renewal British Columbia. She has also been involved with 
successful  technology  transfer  to  Idelix  Software  Inc.  Her  research  focuses  on  the 
visualization, exploration and manipulation of information. Previous experience includes: 
visualizing ecological dynamics for SEED (Simulating and Exploring Eco-system Dynamics) 
and a Braunart’s project, Antarctic Waves, which uses visualization to integrate scientific 
results and sounds from Antarctica to create a tool to inspire musical composition. Dr. 
Carpendale’s research in information visualization and interaction design draws on her 
dual background in Computer Science (BSc and PhD Simon Fraser University) and Visual 
Arts (Sheridan College, School of Design and Emily Carr, College of Art).

Jennifer Dysart

Jennifer  Dysart  is  the  Banff  New Media  Institute  Line  Producer  at  The  Banff  Centre, 
screenwriter  and director. Prior  to  being the Line  Producer she was employed as the 
Coordinator  of  Workshops  and  Summits  for  the  BNMI.  She  received  her  BA  in 
anthropology and women’s studies from the University of British Columbia (UBC). She 
was employed by the Museum of Anthropology at University of British Columbia from 
1993-2000, as an ethnology and media assistant, intern, collections researcher, and tour 
guide. Before coming to The Banff Centre she was intern at the International Office and 
the Canadian Studies Centre at the University of Aarhus, Denmark.  Currently, she is 
awaiting news about her M.F.A applications. In 2006, she will depart The Banff Centre for 
a career in Film Production.
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Iwona Erskine-Kellie

Iwona Erskine-Kellie works for the Banff New Media Institute as the BNMI Assistant and 
in-house  graphic  designer/photographer.  Her  previous  position,  as  Web  Production 
Assistant, was with HorizonZero.ca,  an online publication for digital  art and culture in 
Canada. 

Her native country is the dazzling land of Poland, where she got the "bug" for appreciating 
art and beauty. She graduated from Seneca College in Toronto with a diploma in digital 
media  production  program,  and  completed  computer  graphics  design  and  layout 
programs. Since graduation she has been pursuing a career in the multimedia art and 
performance workplace.

For the past 10 years she managed a small business and dealt with many aspects of 
computer  graphics,  Web design,  desktop publishing,  printing  and presentations,  word 
processing, database, management, marketing, and interaction.

Colin Funk

Colin Funk joined Leadership Development as Director of Creative Development in 1994. 
Colin is well known for his ability to artfully assist individuals, teams, and organizations to 
enhance  their  capacity  for  creativity  and  innovation.  Colin  served  as  Community 
Development officer for the Town of Banff from 1990 to 1994. During his tenure, Colin 
worked with a myriad of stakeholder groups (including 120 not-for-profit organizations in 
the Bow Valley) building capacity in Board Governance, Volunteer Development, and Fund 
Development.

Colin has spent the last 20 years working as an actor, director and theatre producer 
throughout  western  Canada.  He  is  a  graduate  of  the  British  Columbia  Institute  of 
Technology – with a special focus on Broadcast Communications (1981), and a graduate 
of the Vancouver Playhouse – specializing in Theatre Arts and Dramaturgy (1985).

Colin is  the founder and Artistic Director of Precipice Theatre based in Banff, Alberta. 
Since 1989, Colin has led the creation of unique leadership development initiatives that 
bring the arts, ecology and business together through the medium of Theatre. Colin is a 
renowned  speaker, lecturer, facilitator, writer, and  program  designer  in  the  area  of 
creativity, innovation, community development, and environmental education. 

Over the last 10 years, Colin has also played a number of diverse roles both as an Arts 
Administrator and Program Developer with The Banff Centre. More recently, Colin has 
taken the  role  of  Director, Creative  Development  and  Manager  of  The  Banff  Centre’s 
Leadership Learning Lab. 

Colin  is  currently  pursuing a  Master  of  Arts  degree  in  communications and is  a  firm 
believer in the power of the arts as a transformative means for increasing our capacity as 
teams, organizational and community leaders.
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Susannah Gardner

Susannah  Gardner  is  the  co-founder  and  creative  director  of  Hop  Studios  Internet 
Consultants,  a  Web design  company specializing  in  custom Web solutions  for  content 
publishers.  Her  partner  in  life,  crime  and  work  is  Travis Smith,  formerly  editor  of 
Variety.com. 

Susannah is also a freelance writer and author; her latest book is “Buzz Marketing with 
Blogs for Dummies.” She is the co-author of “Dreamweaver MX 2004 for Dummies,” from 
Wiley Publishing, and “Teach Yourself Visually: Dreamweaver MX 2004,” also from Wiley 
Publishing. She just completed “BitTorrent for Dummies.” 

From 1997 to 2003, Susannah was an adjunct professor at the University of Southern 
California School for Communication, where she taught in the School of Journalism. Her 
classes in online publishing took students from zero to Web site in one semester. 

Prior  to  running  Hop  Studios,  Susannah  worked  in  the  Online  Journalism  and 
Communication  Program at  the  University  of  Southern  California,  writing  curriculum, 
teaching, and conducting research at the intersection of technology and journalism. She 
was  a  senior  editor  of  the  Online  Journalism Review, still  the  media  industry’s  only 
Internet-focused  journalism  publication.  Susannah  also  spent  four  years  at  The  Los 
Angeles Times, one of six editors responsible for launching that newspaper’s Web site. 
During  her  time  at  LATimes.com,  she  established  the  site’s  multimedia  lab,  which 
produced ground-breaking Web audio, video and animation. She also launched and edited 
MetaHollywood, an online-only publication that covered new Hollywood technology and 
was LATimes.com’s single largest revenue source in 1998. 

Susannah earned bachelor’s degrees in Print Journalism and American literature at USC. 
Today she is pursuing a master’s degree in Public Art Studies, examining issues that cross 
the traditional boundaries of Internet publishing, journalism and art. 

Visit  the  companion  blog  for  “Buzz  Marketing  with  Blogs  for  Dummies”  at 
www.buzzmarketingwithblogs.com. To learn more about her Web design company, visit 
www.hopstudios.com. She keeps a personal blog at www.unfavorablepink.com. 

Judy Gladstone

Judy  Gladstone  has  been  the  executive director  of  Bravo!FACT (Foundation to  Assist 
Canadian  Talent;  www.bravofact.com)  since  1997.   Bravo!FACT (Foundation to  Assist 
Canadian Talent) was established  in  1995 by Bravo! and  CHUM Television to  provide 
grants for the production of Canadian short films and videos covering a wide range of arts 
disciplines. Bravo!FACT has distributed close to ten million dollars in grants for almost one 
thousand shorts across the country. 

Bravo!FACT-funded shorts have been screened and won awards at prestigious festivals 
around the world, including Cannes, Sundance and the Toronto International Film Festival.

Ms. Gladstone also administers MaxFACT (www.maxfact.org), established in the autumn 
of 1997 when MusiMax, the Québecois music channel, was launched by CHUM Television 
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and Astral Media. In 2002 Les Fonds Harold Greenberg became an annual contributor to 
MaxFACT.
 
From 1993 to 1995, Ms. Gladstone was coordinator of the CIDA-funded Canada Fund for 
Dialogue and Development, providing grants enabling Israelis and Palestinians, Jordanians 
and Egyptians, to work together on cultural and other projects. 

As cultural attaché at the Canadian Embassy in Tel Aviv from 1991-1993, Judy was in the 
wonderful  position of  presenting the best of  the Canadian cultural scene to a foreign 
audience.

Born  in  Montréal,  Ms.  Gladstone’s  university  education  includes  a  B.A.  (from  Laval 
Université, Québec City, Québec), and a graduate degree (from the Sorbonne, France). 

Cristi Hawtin

Cristi  Hawtin  possesses  over  13  years  of  product  management,  sales  and  marketing 
experience  in  the  new  media,  telecommunications,  film  and  video  industries.  She 
presently  holds  the  position  of  Global  Product  Manager, Customer  Service  at  Toronto 
based software company, Alias Systems.

Prior to joining Alias Systems, Cristi held the position of Director of Collaborative Services 
at  Bell  Canada.  Over  the  4 ½ years at  Bell  Canada,  Cristi  worked on a number  of 
projects,  including  the launch o the Bell Canada Collaborative Centre, and several new 
media products in conjunction with Bell Globemedia.

Cristi has also held the positions of General Manager; E-commerce at Skinmarket, a Santa 
Barbara based online retail cosmetic company, Managing Director for CTVSportsnet.com 
at ExtendMedia, and Sales Executive at Digital Equipment Corporation.

Cristi received a B.A Honours in Economics from Carleton University in 1994. 

Christene Hirschfeld

Christene is a partner at the law firm of Boyne Clarke in Nova Scotia.
The majority of her practice relates to intellectual property matters, with an emphasis on 
entertainment and information technology law.  She acts for the Royal Bank of Canada in 
connection with the financing of knowledge-based industries as well as for producers and 
production companies in Atlantic Canada.

Christene is  the Chair  of  the Canadian Bar Association's national  Intellectual  Property 
Section, Chair of the Intellectual Property Institute of Canada's Informals Group (Halifax), 
a lecturer at Dalhousie University Law School, past chair of the Nova Scotia Chapter of 
Canadian Women in Communications, & a past director of the Information Technology 
Industry  Alliance  of  Nova Scotia  (ITANS).  She  is  often  invited  to  speak  on  matters 
relating to intellectual property and entertainment law. 

Penny Jennett
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Dr. Penny Jennett, Head of the Health Telematics Unit and Professor of Community Health 
Sciences  and  previous  Director  of  the  Office  of  Medical  Education  in  the  Faculty of 
Medicine,  University  of  Calgary  is  recognized  internationally  for  her  expertise  in 
telehealth, health telematics, health informatics and health education.

At the University of Calgary, she chaired a Research Group for seven years, served a term 
in Senior Administration, and was involved in leading a submission for a National Network 
of  Centres  of  Excellence in  Telehealth. She chaired the  Implementation Team for  the 
Alberta Telehealth Initiative; co-chaired the U of C Learning Enhancement Envelope for 
three years, an Alberta initiative to enhance learning and teaching through the use of 
technology; and serves as the Vice-chair for the Board of Netera, formerly WURCNET, the 
Western University and Industry Research Consortium). Dr. Jennett chaired the National 
ACMC/MRC Research in Medical Education committee for three years. She is President-
elect,  Treasurer and  Founding Member  of  the  Canadian  Society  of  Telehealth, and  a 
member of the Board of CANARIE Inc. Dr. Jennett is an Advisory Board Member for the 
Ottawa Heart  Institute  Telehealth Initiative,  and sat  on  Health  Canada's  Peer Review 
Committee of the National First Nations Telehealth Research Project. Further, she leads a 
national telehealth initiative to build capacity in rural remote areas through technology-
enabled solutions.

Dr. Jennett is the Project Leader (in collaboration with Health Canada, Industry Canada, 
CANARIE, and the Canadian Society of Telehealth) for the EU-Canada Collaboration on 
Health  Telematics  Initiative,  and  is  a  member  of  the  Germany-Canada  Telehealth 
Initiative. She is also a member of two editorial boards of peer-reviewed journals and 
reviews for several funding agencies and peer-reviewed journals.

Dr. Jennett  was  the  first  Ph.D.  in  a  Canadian  Faculty of  Medicine  to  be  awarded  a 
Canadian Life and Health Insurance Association Scholarship, and was a Research Fellow 
during  her  graduate  studies  at  the  College  of  Human  Medicine  at  Michigan  State 
University.

Prior to graduate work, she trained at Regina Grey Nun's Hospital, Regina, and practised 
in leadership positions as a health records administrator for approximately a decade. She 
was with the College of Medicine, University of Saskatchewan, for 12 years prior to arrival 
at the Faculty of Medicine, University of Calgary, over 15 years ago.

Christina Kargillis

With training in visual arts, communications, and adult education, Christina Kargillis has 
combined ten years of experience in journalism, public relations and adult education with 
her  lifelong  involvement with  the  arts.  She  has  provided educational  consultancy  for 
Australia's  arts  and  media  industries  as  well  as  support  for  Australia's  national  arts 
association. She has developed a broad spectrum of promotional events and produced 
content  for  numerous  publications  where  her  input  has  extended  from research  and 
writing  to  design  and project  management.  Christina  practices  mainly  in  writing  and 
photography, as  well  as  allied  visual  arts.  Her  key focus  is  transformative education 
through creativity and she is currently completing her masters in adult education in this 
area.
Susan Kennard
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Susan Kennard is the Director & Executive Producer of The Banff New Media Institute. In 
2006 Susan is  currently  working with BNMI stakeholders to  deepen the focus of  the 
institute’s activities in two primary areas: new media and technology in relationship to 
living culture(s); the positioning of media arts in the knowledge economy. From 1998 - 
2005 Susan held the role of Executive Producer, BNMI. 

Prior  to  her work with The Banff  Centre,  Susan worked in  television as  an associate 
producer for the International Hour, CBC Newsworld, and Dateline NBC, and in radio as a 
writer/broadcaster for CBC Radio and as station manager for CKIZ radio in Pincher Creek, 
Alberta. She has extensive experience in policy development, training, and advocacy for 
the  not-for-profit  community  radio  sector  across  Canada,  and  is  the  co-founder  of 
radio90.fm, a hybrid net/fm pirate radio station.

In June 2005, Susan concluded a master’s degree in Communication for Development 
from the University of Malmo, Sweden, completing a thesis on the relationship between 
contemporary  art  practice,  social  change  and  civil  society  in  post-war  Sarajevo.  In 
October 2005 this research was published in the online magazine  Global Tider and has 
since  been  featured  in  the  "strategic  thinking"  section  of  the  Communication  for 
Development online portal http://www.comminit.com

She  is  a  member  of  the  program  committee  for  the  International  Symposium  on 
Electronic Art (ISEA) 2006, a member of the 2005/2006 Media Arts Advisory Committee 
for the Canada Council and on the international jury of the Banff World Television Festival. 
Susan is also a co-director of the Interactive Project Lab, a national bilingual new media 
accelerator program in partnership with The Canadian Film Centre (Toronto) and L'institue 
Image et du Son (Montreal).

http://www.banffcentre.ca/bnmi
http://radio90.fm

Cheryl L'Hirondelle

Cheryl  L'Hirondelle  (waynohtÃªw)  [http://www.ndnnrkey.net]  is  an  Alberta-born 
interdisciplinary artist of mixed ancestry (Cree / Metis / German / Polish).  Since the early 
1980s, she has created, performed, and presented work in a variety of disciplines (music, 
storytelling, performance art, theatre, video, and net.art). She has also worked as an arts 
programmer,  cultural  strategist/activist,  arts  consultant,  producer,  and  director  - 
independently  and  with  various  artist-run  centres,  tribal  councils,  and  government 
agencies. 

Recently,  she  was  guest  creative  consultant  for  horizon  zero's 
[http://www.horizonzero.ca] edition 17: TELL devoted to aboriginal digital storytelling. 

Her net.art database project Treaty Card [http://treatycard.banff.org] is part of Walter 
Phillips Gallery's [http://www.banffcentre.ca/wpg/] touring Database Imaginary exhibition 
curated by Sarah Cook, Anthony Kiendl and Steve Dietz. She is currently developing and 
will be teaching a First Nations net.art course for Emily Carr Institute of Art and Design in 
Vancouver and was featured in Caught in the Act: An Anthology of Performance Art by 
Canadian Women, edited by Tanya Mars and Johanna Householder.
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Stephanie MacKendrick 

Stephanie MacKendrick has worked in the communications industry more than 25 years, 
nine of those as President of Canadian Women in Communications.  Stephanie holds a 
degree in journalism from Ryerson Polytechnical Institute (now Ryerson University), and 
worked as a journalist for ten years, including five with Broadcast News Ltd., (a division of 
The Canadian Press).  She then moved to corporate communications, serving at Rogers 
Communications Inc., and Unitel Communications (now MTS Allstream) before becoming 
Vice President, Corporate Communications at Atlantis Communications Inc., (now Alliance 
Atlantis Communications).   Stephanie joined Canadian Women in Communications (CWC) 
in 1996 and has helped develop CWC into a leading women’s professional organization.

Stephanie is also known internationally for her work to promote women’s involvement on 
corporate boards. She is Vice President of the Board of Directors of The International 
Alliance for Women (TIAW), a worldwide umbrella organization of women’s networks and 
Chair of its Women on Boards initiative.  She has spoken on the topic in Europe and North 
America, most recently at the European Women’s Management Development conference 
in Berlin, Germany in September 2005.

Stephanie is also a passionate advocate of diversity and served in 2004 as Chair of the 
Board the Innoversity Creative Summit, a not-for-profit organization that fosters diversity 
in Canadian media.  In September 2005, she received the Innoversity Angel Award for 
commitment to diversity.

In  November  2005,  Stephanie  was named one  of  the  100  Most  Powerful  Women in 
Canada by the Women’s Executive Network.

Stephanie is married and has two sons, 17 and 20. 

Melany Nugent

Melany  is  currently  helping  to  develop  the  online  archives  for  the  Banff  New  Media 
Institute. This is her second time doing a workstudy at the Banff Centre, the first being in 
2003 as a Computer Technician for Interactive Media. After graduating from Digital Arts 
and  Media  in  Edmonton  she  worked  at  Latitude  53  Gallery  before  moving  to  the 
mountains.  Melany’s  recent  accomplishments  include  being  the  Director  of 
Communications for the Alberta Centennial Mountain Expedition, a project created to help 
celebrate Alberta’s 100th birthday, as well  as working in Ghana with NGOs developing 
awareness in  communities  affected by HIV/AIDS. She is  currently  completing her  BA 
Communications through Athabasca University.
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Emily Paige

Emily Paige is the BNMI Coordinator, working with public programs and strategic research 
for the BNMI. Her previous experience is centered around a fine arts career including work 
with  the  Canadian  Museum  Association  on  the  Young  Canada  Works  Program,  the 
Canadian Clay and Glass Gallery, the University of Waterloo Gallery, and volunteer work 
with  the  Kitchener  Waterloo  Gallery.  Emily's  career  stems  from  studies  in  English 
Literature and Fine Art History, including a semester abroad at the Université Lyon II, 
France. Her travels have also encompassed working/living in London and Manchester, and 
exploring Spain, Germany, Scotland and Egypt. With origins in a small town in the Ottawa 
Valley, Emily is excited about her relocation to the natural landscape of Banff and looks 
forward to learning about Canada on a cultural level, nationally. Emily is also a practicing 
visual  artist  with  work  that  incorporates  the  use  of  word  and  image  through  large 
paintings.

Lally Rementilla 

Lally  Rementilla  is  an  accomplished  strategic  financial  management  professional  with 
experience in a variety of communications, technology and cultural organizations.
 
In her current role, Lally is the Vice President of Business Planning and Analysis of Lavalife 
Corp., a leading provider of technology-based meeting services for singles.  She leads a 
team  responsible  for  supporting  the  company’s  corporate  finance  and  business 
development initiatives, as well as providing strategic planning and analytical expertise for 
the company’s phone, web and mobile businesses.  She serves on a team that has been 
involved in evaluating various corporate development options.  She also played an integral 
role in the purchase of Lavalife by Vertrue Incorporated in April 2004.
 
Prior  to  Lavalife, Lally  was Area Vice  President  Finance and Contract Management  of 
Lucent Technologies Canada, a telecom equipment manufacturer.  Through her company, 
PassionPlay Enterprises, she served as a consultant for FRONT, an international broadcast 
design and branding firm and was co-founder of Kusina.cc, an online Filipino food website.
 
Lally currently serves as Chair of the board of directors of Theatre Passe Muraille, one of 
Canada’s first and largest alternative theatre companies.  She also serves as a member of 
the board of directors of Canadian Women in Communications.  Her past affiliations have 
included Innoversity (Treasurer), Toronto Board of Trade Young Professionals, Women in 
Capital Markets and Canadian Investor Relations Institute.
 
Lally holds an MBA from York University and a BA in Communications from the Ateneo de 
Manila University.  Lally is a Certified Management Accountant.  
 
Based in Toronto, Lally indulges in ashtanga yoga, traveling, entertaining and spending 
time with family and friends.  She and her cool husband, Derek, are expecting their first 
child in April 2006.  
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Cindy Schatkoski 

Cindy Schatkoski has been the Program Manager of the Banff New Media Institute since 
November 2005. In this role, Cindy works on the long term strategic planning and the 
overall development and delivery of the Banff New Media Institute program. Cindy has 
worked at The Banff  Centre since 1998 in various program support  and development 
capacities as part of the Media & Visual Arts and the Banff New Media Institute/Research 
Departments,  including  managing  the  co-production  program,  line  producing  the 
nationally acclaimed HorizonZero online publication dedicated to the best in Canadian New 
Media, administrative co-ordination of workshops and special events, and administrative 
support  and communications. She is also the Communications Director  of Radio 90 – 
Cellular Pirate Radio http://radio90.fm and specializes in online and FM radio training and 
development. 

Elizabeth Vander Zaag 

Elizabeth Vander Zaag is a Vancouver new media artist. Beginning in the mid seventies 
with  a  computer  animated  character  named  Digit, I  have  been  exploring  digital 
sensibilities  using  the  myriad  of  technologies  that  have  come  on-stream  as  well  as 
developing  custom prosodic  speech  software  named  Speak  and  Yell. Currently  I  am 
exploring  the  complexities  of  acoustics  in  language  at  the  Interdisciplinary  Speech 
Research Lab at UBC where I am a graduate student. I am interested in intercultural new 
media practice and am developing an interactive work called Mother Tongue. Another area 
of interest is feminism and language. An interactive speech installation entitled Talk Nice, 
produced  through  the  Banff  Centre,  explores  the  tentative  attitude  of  teenage  girls 
speaking uptalk. Talk Nice and more recently Bow Wow have been exhibited extensively 
throughout the world. 
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CONTACT INFORMATION

Luke Azevedo
Director
Creative Electronic Environment
The Banff Centre
Box 1020 Stn. 40
Banff, AB T1L 1H5 Canada
Tel: (403) 762-6196
Fax: (403) 762-6665
Email: luke_azevedo@banffcentre.ca 
URL: www.banffcentre.ca/mva

Sarah Anson-Cartwright
Director - Government Relations
Bell Canada
110 O'Connor Street, 14th floor
Ottawa, ON K1P 1H1 
Tel: (613) 781-8576
Fax: (613) 230-8813
Cell:  (613) 297-1212
Email: 
sarah.anson-cartwright@bell.ca

Jane Arnot
Senior Director Business Development 
CanWest Interactive
201 Portage Avenue, 30th Floor
Winnipeg, MB R3B 3L7
Tel: (204) 926-4326
Fax: (416) 442-3389
Cell: (204) 228-3716 
Email: jarnot@canwest.com

Martha (Marty) Avery
Chief Catalyst, What If?
136 Eagle Terrace Road 
Canmore, AB T1W 2Y5    
Tel: (403) 670-5556 
Fax:  (403) 609-3062
Cell: (416) 803-7679
Email: marty@what-if.ca
URL: www.what-if.ca

Ed Bamiling
Ceramics Facilitator
Media Visual Arts
The Banff Centre
Box 1020 Stn. 40
Banff, AB T1L 1H5
Tel: (403) 762-6211
Fax: (403) 762-6665
Email: ed_bamiling@banffcentre.ca 
URL: www.banffcentre.ca/mva

Ann Barnes
General Counsel
Vice-President Business Affairs
Insight Sports Ltd.
184 Pearl Street, Suite 302
Toronto, ON M5H 1L5
Tel: (416) 593-0915, ext: 244
Fax: (416) 593-6991
Cell: (416) 616-2118
Email: abarnes@insightsports.com

Deborah Beatty
Vice President & General Manager
Corus Radio Interactive
BCE Place 1630 181 Bay
Toronto, ON M5J 2T3
Tel: (416) 583-2717 
Fax: (416) 583-2704 
Cell: (416) 720-1190 
Email: dbeatty@corusent.com

Michel Blondeau
CEO/IDEAGUY, ecentricarts inc.
317 Adelaide St. W. # 309 
Toronto ON M5V 1P9
Tel: (416) 644-5000 x222 
Fax: (416) 644-1004 
Cell: (416) 997-7131 
Email: mblondeau@ecentricarts.com
URL: www.ecentricarts.com
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Michelle Bohning
Line Producer, Accelerator 
Banff New Media Institute
The Banff Centre
Box 1020, Stn. 40
Banff, AB T1L 1H5
Tel: (403) 762-6591
Fax: (403) 762-6665
Email: 
michelle_bohning@banffcentre.ca
URL: www.banffcentre.ca/bnmi

Jan Bozarth
President
Blue Arrow Incorporated
14224 Hunters Pass
Austin TX 78734 USA
Tel: (512) 266-2723 
Cell: (512) 797-4240
Email: jan@bluearrowmedia.com
URL: www.bluearrowmedia.com

Lisa Bowditch
Library Manager
Rogers Sportsnet
9 Channel Nine Court 
Toronto, ON M1S 4B5
Tel: (416) 332-5661
Fax:  (416) 332-5629
Email: 
lisa.bowditch@sportsnet.rogers.com
URL:  www.sportsnet.ca

Lili Campbell
President and Creative Director
Footprint Strategic Communications, 
Inc.
276 Carlaw Ave. Suite 308
Toronto, ON M4M 3L1

Tel: (416) 462-2870
Fax:  (416) 462-0901
Cell:  (416) 409-9479
Email: 
lcampbell@footprintstrategic.com
URL: www.footprintstrategic.com

Sheelagh Carpendale
Professor
University of Calgary
78 Moraine Road
Canmore, AB T1W 1J7
Tel: (403) 220-6055
Fax:  (403) 284-4707
Email: sheelagh@cpsc.ucalgary.ca

Pamela Chan
Producer
Macleans.ca
One Mount Pleasant Road 
Toronto, ON M4Y 2Y5
Tel: (416) 764-1208
Fax: (416) 764-1610
Cell: (416) 272-7828
Email: 
pamela.chan@macleans.rogers.com

Terry Dinsmore
President
Dinsmore Media
#1002, 1768 West 8th Avenue
Vancouver, BC V6J 5L2
Tel: (604) 736-2310
Fax: (604) 736-2390
Cell: (778) 834-2310
Email: terry_dinsmore@telus.net

Jennifer Dysart
Line Producer
Banff New Media Institute
The Banff Centre
Box 1020 Stn. 40
Banff, AB T1L 1H5 Canada
Tel: (403) 762-6443
Fax: (403) 762-6665
Email: jennifer_dysart@banffcentre.ca 
URL: www.banffcentre.ca/bnmi
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Iwona Erskine-Kellie
BNMI Assistant & New Media Artist
Banff New Media Institute
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Bristol, BS1 5UH, UK
Tel: 0117 915 8200
Fax: 0117 915 8201
Cell: 07951 742 268
Email:
jo.morrison@nestafuturelab.org
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Email: david.bhamjee@sympatico.ca
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Tel: (416) 204-7697
Fax: (416) 362-6804
Cell: (647) 999-5538
Email: lwoznica@secor.ca
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READING MATERIALS

BLOGGING LAB 

HOSTING AND FTP TRANSFERS

Your blog will be hosted at wordpress.com. 

Shared webspace on the Banff Center’s server has been set-up for hosting your 
images and sound files needed for BNMI’s Blog Project where you can link to them. 
This is shared space, with total quota of 500Mg.  Please be file size conscious and 
share this space 22 ways. 

Filezilla (for PC’s) you will require for FTP transfers are installed on all the computers 
in the Lab.

You will need the following information to use Filezilla:

URL: glacier.banff.org
User: cwccorus
Pass: cwccorus

The path to the files uploaded will be http://blog-project.banff.org/2006/ 

Each user can add their own folder to this directory, ie:
http://blog-project.banff.org/2006/MySpecialUserName/image.jpg

Here are directions on how to connect to the server using filezilla:
http://help.banff.org/using_filezilla/index.html

Upload all images into the ‘html’ folder after you have logged in with you FTP Client 
(Filezilla is commonly called FTP Clients).  For example, if you upload the image 
‘my_picture.gif’ to the ‘html’ folder, you can link to it on your blog with the following 
code:

<img src=”http://blog-project.banff.org/my_folder/my_picture.gif”>

It is important that all the files are named properly before uploading to the server. 
This means:

1. All lower case
2. No spaces
3. No symbols such as: !@#$%^&*(),./<>?
4. If you need to separate words, try an underscore: my_file.gif
5. All your image files should end with the appropriate suffix.  Most common are 

.jpg for JPEG formatted images and .gif for GIF images.

http://help.banff.org/using_filezilla/index.html
http://blog-project.banff.org/2006/MySpecialUserName/image.jpg
http://blog-project.banff.org/2006/


UNDERSTANDING DIFFERENT WEBLOG SOFTWARE AND SYSTEMS

Some of the most common questions asked by individuals contemplating on starting a 
weblog are: How do you choose the right platform? Where is the best place to blog? 

Unfortunately, there are no straightforward answers. However, understanding the 
different types of blogging platforms may help in the decision-making process. 
Blogging platforms are best categorized as follows: 

Hosted weblog providers; 

Stand-alone weblog software; and 

Remote weblog systems.

Hosted weblog providers 

This is a type of blogging platform where the user simply needs to sign up and set up 
a weblog account in order to start blogging. There's no need to install any programs, 
get a separate web hosting account, and/or obtain a domain name. 

Examples of such a blogging platform include: MindSay, TypePad, LiveJournal, Xanga 
and ModBlog. 

Starting a blog using hosted weblog providers is the simplest way to begin blogging. It 
suits most people who wish to start a weblog. 

The basic set up guideline for users: Just visit the weblog provider's site, sign up for 
an account, and specify some basic weblog customization (choose blog templates, 
color themes, etc.). Then, just start writing blog entries. All users are given a weblog 
address that goes something like http://username.weblogprovider.com/. 

This set up is perfect for bloggers who do not wish to study any complicated technical 
matters like HTML, CSS, and/or FTP, among others. 

Stand-alone weblog software

This is a type of blogging platform where the user needs to download and install 
weblog software in a free or paid web host in order to start blogging. Examples are: 
WordPress, Movable Type, and Greymatter. 

The typical set up guideline for users of this platform type is as follows: visit the 
weblog software's site, check the requirements to run the program, download the 
software, install the software on your web host, and follow set up procedures. You can 
later customize the templates and incorporate add-ons and plugins to improve your 
weblog. If you don't have a web host yet, About's Guide to Personal Web Pages Linda 
Roeder has some recommendations. 

This type of weblog platform is good for bloggers who wish to have more freedom in 
tweaking their blogs, either by customizing templates or adding functionality. Users of 
stand-alone weblog software are comfortable with handling technical matters. Or, at 
least, they can rely on someone who can help them with such things. 

http://personalweb.about.com/cs/homepagehosting/index.htm
file:///od/blogplugins/
file:///od/blogaddons/
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.modblog.com%2F
http://www.movabletype.org/
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.wordpress.org%2F
file:///cs/blogsglossary/g/FTP.htm
file:///cs/blogsglossary/g/CSS.htm
file:///cs/blogsglossary/g/html.htm
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.modblog.com%2F
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.xanga.com%2F
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.livejournal.com%2F
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.typepad.com%2F
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.mindsay.com%2F


UNDERSTANDING DIFFERENT WEBLOG SOFTWARE AND SYSTEMS

Remote weblog systems 

This type of blogging platform is somewhere in-between using a hosted weblog 
provider and stand-alone weblog software. Users can have the option to host the 
weblog system in the built-in weblog host (like BlogSpot for Blogger.com users) or use 
their own web host and domain. Other than Blogger.com, another example of this 
type of platform is WebCrimson. 

In this type of platform, the typical set up guideline follows that of the weblog host 
provider set up, if the user chooses to have his or her blog hosted. However, if the 
user opts to run the weblog system in his/her own web host and use his/her own 
domain name, the user needs to provide the FTP details to the remote weblog system 
of choice. The web host company should provide the FTP details, which usually 
comprise of the FTP address (e.g., ftp.yourdomain.com), FTP account user name and 
password. 

Bloggers who will benefit the most from this type of platform are those who wish to 
have some control over their weblogs but do not wish to go through the trouble of 
installing weblog software. 

Source: http://weblogs.about.com/od/weblogsoftwareandhosts/a/weblogplatforms.htm

http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.webcrimson.com%2F
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.blogger.com%2F
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.blogger.com%2F
http://clk.about.com/?zi=1/XJ&sdn=weblogs&zu=http%3A%2F%2Fwww.blogspot.com%2F


BASIC BLOG CREATION

In this session we will be using free blog provider at www.wordpress.com, a web-
based tool that helps you publish to the web instantly.

Blog is a web page made up of usually short, frequently updated posts that are 
arranged chronologically—like ‘what’s new’ page or a journal.  You will be able to post 
in your blog links and commentary about other web sites, to news about a 
company/person/idea, to diaries, photos, poetry, mini-essays, project updates, even 
fiction.

 Please log-in to the website www.wordpress.com and create your own blog 
account by pressing “Get a WordPress Blog now” button, filling all fields in 
the form, by clicking on the “Sign Up” button.

 You will receive an email to the email address you provided telling you that 
your new WordPress.com blog has been successfully set up and providing you 
with the login information.

 In a Write window you will be able to type content of your blog.  Under the 
Users you can change the Title, Description, and Type of blog, etc. Under 
the Presentation you can change the Current Theme of your blog. After 
posting, you will need to Publish your Blog, otherwise you will lose your 
editing page and you will need to go back and select your blog to open to 
editing pages.  Now you can Create New Posts or Manage Posts to edit or 
delete your posts. 

BRINGING SOUND FILES INTO OUR BLOG

Using Audacity – freeware audio editing program
Open your MP3 sound file in Audacidy:

1. Under the File Menu --> Open. 
2. Locate your sound file from your folder (in the drop down box) and click Open 
3. Under the File Menu go to Save Project and save as .aup (Audacity Project 

file type), name your file and click on Save (saving as Audacity Project file will 
increase processing speed of your audio editing)

4. Click and drag to select audio area you wish to remove (make sure that the 
Selection Tool I in upper left corner is selected) and press Delete on your 
keyboard 

5. Once your sound file is a right size go to the File Menu -->Export As MP3…
6. In the drop box you can edit/name the ID3 tags for your MP3 file, and then 

click OK

Your files are now ready to be linked to your document.

http://www.wordpress.com/


WHAT IS PODCASTING? 

Podcasting is distributing audio or video content via RSS 2.0, or (less commonly) 
Atom. Podcast clients are available, like Juice 
(http://juicereceiver.sourceforge.net/index.php), CastPodder(linux) 
(http://www.castpodder.net/), or iTunes (http://www.itunes.com/) that allow listeners 
to subscribe to your RSS/Atom feed and automatically download your content to their 
portable audio players as it becomes available. 

How It Works 

Create audio or video that you want to share (usually MP3 or MP4) 

Upload the file to a server 

Link to the file in a post in your weblog 

Wordpress automatically includes a link to the file in your RSS/Atom feed 

Listeners "subscribe" with podcast client application to your RSS/Atom feed and 
download new files automatically. 

WordPress creates all the necessary links for you! 

Using WordPress for Podcasting 

Podcasting is seamlessly supported as of Wordpress 1.5. Just link to an audio file in 
one of your posts and WordPress will automatically add the necessary enclosure tag to 
your RSS2 feed to make it useable as a podcast. 

Important: Use a complete, absolute URI when linking to the audio file. Otherwise 
WordPress will not make an enclosure for it. 

Wrong: <a href="my-podcast.mp3">My podcast</a>
 
Right: <a href="http://example.com/my-podcast.mp3">My podcast</a>

That's it — just link to an audio file and it gets taken care of. 

Okay, it's not the only thing you have to do. There is one more step. 

You need to make your RSS2 feed available. Put a link somewhere on your page: 

http://example.com/wordpress/?feed=rss2

Or, if you're using Atom: 

http://example.com/wordpress/?feed=atom

As of WordPress 1.5 the RSS 2.0/Atom links are located on the bottom of the page by 
default. 

http://www.itunes.com/
http://www.castpodder.net/
http://juicereceiver.sourceforge.net/index.php
file:///Glossary
file:///Glossary


WHAT IS PODCASTING? 

Notes: 

As of WordPress 1.5, this only works for posts but not for static pages. 

Make sure the linked file is accessible when you publish your post. Otherwise, 
WordPress won't be able to collect the information it needs from the linked 
files. 

If you change a linked file, republish the post so WordPress can update its file size 
information about the file. 

To get Wordpress to recognize m4a and m4b files as podcasts, you need to make 
sure that your web server is configured to serve them with the right content-
type. Do this by adding the following directives to your Apache configuration 
file or .htaccess file: 

AddType audio/x-m4a .m4a
AddType audio/x-m4b .m4b

Dedicated Podcasts

To create a dedicated podcast feed: 

Create a category in the Admin > Manage > Categories panel for your audio files 
and call it something like "podcasts". 

Assign every post containing an audio link to your "podcasts" category. 

If your blog is at example.com, your podcast feed will automatically be available 
at: 

http://example.com/wordpress/?feed=rss2&category_name=podcasts

Add this to your .htaccess file to make a nice rewrite rule that points visitors directly 
to your podcasts (assumes you've categorised your podcasts as 'podcasts' as in the 
example above): 

#podcast rewrite
RewriteRule ^podcasts/?$ 
/yourWPsubdirectoryhere/index.php?category_name=podcasts [QSA,L]
RewriteRule ^podcasts/feed/(atom|rss2)/?$ 
/yourWPsubdirectoryhere/index.php?feed=$1&category_name=podcasts [QSA,L]

Now, you can give your podcasts feed as http://example.com/podcasts/feed/rss2 for 
RSS2 format, or http://example.com/podcasts/feed/atom for Atom format. (If you 
don't know the difference between the two, give out the first, as RSS2 is generally a 
bit better supported). 



WHAT IS PODCASTING? 

Archive.org issues

Archive.org can be used to host podcast audio files but archive.org uses re-directs on 
the file paths it publishes - this confuses WordPress, and consequently, the Podcast 
publication fails (missing enclosure tag error). 

To avoid this error, if you are hosting your audio files on archive.org, you need to add 
a Custom Field called "enclosure" and paste the full url for the mp3 file in the Value 
field. 

Source: http://codex.wordpress.org/Podcasting



PHOTOSHOP LAB 

PHOTOSHOP EXERCISES

Manipulating and Resizing Images
All manipulations performed on images (except for resizing) can affect either the 
entire image or a selected portion of the image. 

Resizing the Image
 Go to File in the main menu and select Open
 Select your image from drive
 To change the image size select Image Size under the Image menu. 
 There are many methods available for adjusting the image size. These methods 

are: in a Percentage, in Pixels, in Inches, in Centimeters, in Points, in Pica or in 
Columns. 

 Increase or decrease amount of pixels (make sure that Constrain 
Proportions option is checked)

 Change image resolution to 72 pixels (if is not that already)

The size of an image is related to many factors. Primarily image size is measured in 
pixels but Photoshop also measures image size in inches and resolution. The image's 
resolution is very important when printing and since the resolution is set in 
conjunction with image size checking the image size before printing is always 
recommended. 
The option of locking the Proportions ensures the image will retain the correct aspect 
ratio and not distort the image. 
Another option is to lock the File Size. Locking the file size allows changes to affect 
only the resolution of the image without increasing or decreasing the file size. This is 
useful for setting up an image to be printed at a decent quality and not change any 
information in the image in terms of pixels. 
The final option is to use Auto. This option gives the recommended resolution for 
printed output. Enter the number of lines per inch (in terms of screens) to print at, 

The recommended resolution is calculated and is automatically entered in the Image 
Size dialog box. 

 127 x 150, 19.8 Kb 
 64 x 75, 5.8 Kb, Proportions Locked 
 64 x 150, 9.2 Kb, Proportions Unlocked 
 127 x 150, 19.8 Kb, File Size Locked 



PHOTOSHOP EXERCISES

Changing the Canvas Size
Changing the canvas size is different from changing the Image Size. Instead of 
enlarging or reducing the actual image this changes the size of the working space by 
creating a border around the image. Selecting Canvas Size under the Image menu 
brings up another menu.
The nine square grids represents where the existing image will be placed on the new 
canvas. 

The Cropping Tool 
The cropping tool cuts an image according to a rectangular boundary. Select the 
Cropping Tool from the Tool Bar, and draw a rectangle around the cropping region. 
A dotted rectangle will be displayed with four handles at the corners. 

 To Cancel the crop, click outside the rectangle. 
 To Crop the image, click inside the rectangle. 
 To Resize the rectangle, drag on the handle. 
 To Move the rectangle, hold down the Command key and drag on the handles. 
 To Rotate the rectangle, hold down the Option key and drag on the handles. 

Image Adjust
Adjusting Levels – Auto Levels and Levels
Auto Levels is a quick way to adjust brightness, contrast and color-correct an image. 
Levels are another first-step option for image adjustment. If Auto Levels is not right 
for your image, try Levels. Levels give you much more control over the adjustments.

 Go to the Image menu
 Drag down to Adjust
 and down again to Auto Levels

Brightness and Contrast
There are no controls for different areas of the image as there are in the Levels 
option. An example of when to use this option would be if the image overall tone is 
good, but it is a little dark and needs lightening.

 Go to the Image menu
 Drag down to Adjust
 and down again to Brightness/Contrast

The Brightness/Contrast control window appears. 
You will see two slider bars for adjusting your image, one for brightness and one for 
contrast. Adding or reducing brightness/contrast is as easy as sliding the appropriate 
bar to the left or right of center. 
Be sure to check (so a check appears) the preview box so you will see the changes on 
your screen as you make adjustments.

Color Balance Controls
The color controls allow you another option for adjusting color in an image.

 In the Image Adjust Menu
 drag over and down to Color Balance



 the Color Balance Control window appears
PHOTOSHOP EXERCISES

The Color Balance Control window consists of three slider bars for adding or 
subtracting color from the image, the color sliders are: Cyan and Red, Magenta and 
Green and Yellow and Blue.  The colors work together adding from one color and 
subtracting from the other. 

Image Rotate
 Go to Image and choose Rotate option
 Play with those options: 180 degrees, 90 degrees CW and 90 degrees CCW
 Arbitrary – you specify the degree of change and direction
 Free – click and drag on any of the four handles that appear at corners of your 

image

Image Flip
 Go to Image and choose Flip
 Horizontal will swap from left to right and Vertical will swap from top to 

bottom

Image Effects
 Go to Image 
 Choose Scale – changes the scale and proportions of the bounding box
 Then choose Skew – allows the shifting of the bounding box to create a 

trapezoid
 And choose Perspective – creates illusion of perspective

Image Filters 
 Select All – a crawling line will appear around image
 In the main menu go to Filters
 Try out the various filters on selected image. 

Create a Title Image
 First choose a colour for your foreground colour.
 Double click on the the Foreground colour tool – (box on top)
 Select colour from colour palette
 Choose Type Tool from the tool bar menu
 Choose Settings on Type Tool menu including font size and style
 Place cursor in Type Tool window and type.

Some fun things to do with your text image would be to run a filter over it or do some 
perspective on it. Experiment with the steps above.

 Create a signature with the Pen Tool. 

Thumbnails



You may want to create a thumbnail for your image which would appear on your post. 
When clicked on, this thumbnail will link to the larger image. 



PHOTOSHOP EXERCISES

To create a thumbnail follow the steps in Image Size and try a 75 - 100 pixel size for 
the width. 

Saving Images Intended for Web Use
Photoshop .PSD file format is mainly useful for working within Photoshop itself. To use 
on the web compress your image by converting to JPEG or GIF image file formats.
Please Note: The changes should be made on your original image before the 
indexing/GIF procedure. If the image has been converted into a GIF already, some of 
these options will not be available, and you will have already removed valuable 
information from the image. 

The Converting Process 
JPEG
Open your image in Photoshop:

1. Under the Image Menu -->Image Size. 
2. Change inches to pixels (in the drop-down box). 
3. Key in your desired height or width measurement. Check the Constrain 

Proportions so it is Locked. Your file image will be reduced proportionally, 
meaning you only have to key in one number and the other will change too. 

4. Change the Resolution --> 72 pixels per inch. 
5. Click OK. 
6. Under the File Menu -->Save As

Type in the name of your file. Be sure to have no spaces in the file name. 
7. In the Format drop box --> JPEG
8. Select quality between 1 and 10 and check out file size and quality. 

GIF 
Open your JPEG image in Photoshop:

1. Under the Image Menu --> Image Size. 
2. Change inches to Pixels (in the drop down box) 
3. Key in your desired height or width measurement. Check the Constrain 

Proportions so it is Locked. Your file image will be reduced proportionally, 
meaning you only have to key in one number and the other will change too. 

4. Change the Resolution --> 72 pixels per inch 
5. Click OK. 
6. Under Mode --> Indexed color.

Choose 8 bits, Adaptive Palette, and Diffusion Dither.
By sampling the image and using the best selection of colors available, this 
process drops the image's 16 million color palette down to 256 (8 bit) to create 
a new palette. 

7. Under the File Menu -->Save As
Type in the name of your file. Be sure to have no spaces in the file name. Be 
sure to add (if the software does not) the .GIF extension so your browser can 
read it. 

8. In the Format drop box --> Compuserve GIF. 
Remember, 72 pixels equals 1 inch on most computer screens.
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PHOTOSHOP 7.0 TOOLS



PHOTOSHOP FILTERS

Blur Filters
The standard blur filters are generally very subtle. They are useful for removing harsh 
edges on an image. Blur and Blur More do not have any settings, Gaussian Blur 
has several used to vary the effect. 

Simple Blurs: Blur, Blur More, and Gaussian Blur Filters.
Special Blurs: Motion Blur Filter, Radial Blur with Spin, Radial Blur with Zoom.

Distort Filters
The distort filters "reshape" an image rather than altering the colors. They are: 
Pinch, Polar Filter-try from Rectangular to Polar, Polar Filter-try from Polar to 
Rectangular, Ripple, Shear, Sphere, Twirl, Wave, and Zigzag Filters.

Noise Filters
The Noise filters are used both for adding and removing "noise". The Despeckle filter 
can be useful for removing speckles from a dusty scan or removing interference from 
a video still. They are:  Add Noise, Median, Despeckle, Dust and Scratches, and 
Mezzotint Filters.

Pixelate Filters
These filters affect pixels be joining pixels with similar colors according to different 
tolerances:  Facet, Mosaic, and Fragment Filters.

Render Filters
The Render Filters allow one to add affects to an image which are similar to 
renderings:  Clouds, Difference Clouds, Lens Flare, and Lighting Filters. 

Sharpen Filters
The sharpening filters are opposite to the Blur Filters. The Unsharp Mask is a 
sharpening filter equivalent to Gaussian Blur. Those filters are: Sharpen, Sharpen 
Edges, Sharpen More, and Unsharp Mask Filters.

Stylize Filters
The Stylize filters create a variety of effects to alter an image. They differ from the 
Distort filter since they affect the image's colors more then the placement of its pixels. 
They are: Halftone, Crystalize, Facet, Mosaic, Diffuse, Extrude Filter into 
Blocks, Extrude Filter into Pyramids, Emboss, Find Edges, Trace Contour, 
Fragment, Solarize, Tiles, Wind, and Pointillize Filters.

Other Filters
Custom, Minimum and Maximum Filters, Offset, RGB-HSl Swap, Drop Shadow, 
and cMultiDemo Filters.



IMAGE FILE FORMATS

Photoshop is a pixel based image manipulation program. Photoshop can import 
downloaded image files, rendered images for manipulation, scanned and images from 
digital cameras.

.IFF
Amiga Interchange File Format - Photoshop can read and write to this file format at a 
maximum of 8 bits per pixel. 

.BMP
Bitmap - Photoshop can read and write up to 24-bit files. An RLE compression can be 
used for any file under 8-bits. 

.EPS
Encapsulated Postscript - EPS formats are generally very useful for printing to 
postscript printers. EPS files can be written up to 32-bit CYMK (Cyan, Yellow, Magenta, 
Black) file, which is useful for bringing files into other programs such as Illustrator and 
QuarkXPress. 

.GIF
Graphics Interchange Format - Photoshop reads and writes 8-bit files. Developed by 
CompuServe it uses a very efficient LZW compression method. 

.JPG
Joint Photographic Experts Group - Photoshop reads and writes up to 32-bit JPEG files. 
JPEG uses a variable compression method which causes a loss in quality as the 
compression is increased. However, the compression ratio can be up to 1/30th of the 
raw image size. Please note that the JPEG format "loses" information about your 
image in order to compress the file size. The amount of quality versus compression is 
selected by the user before saving. Although the loss of information may be hardly 
noticeable at first, if you continue to edit and resave your image several times in JPEG 
format, more and more information will be lost every time the file is saved. Therefore 
it is recommended that you only save your final image in JPEG format. 

.PCX
PC Paintbrush - This file format will write up to 24 bit images. 

PHOTOSHOP
Photoshop format (.PSD) - This format is the only format that supports all of the color 
modes including Duotones, Lab colors, and Multichannel. This may be useful when 
working inside of Photoshop itself; however, this file cannot be compressed and is not 
very compatible with other programs. 

.PICT
Macintosh PICT format - This is a widely used Macintoch file format which stores 16 or 
32 bits per pixel. It can also compress files using JPEG compression. Please read 
section on JPEG to find out more about lossiness. 

.RAW
Raw image format - This file format can be useful for transferring an image to 
different platforms that may not read similar file formats. It simply reads and writes 
the raw information of the image 



IMAGE FILE FORMATS

.TGA
Targa - Photoshop can read and write 16-bit, 24-bit and 32-bit files. Usually Targa file 
are used to write 32 bit files which would be 24 bit true color with an 8 bit Alpha 
channel. 

.TIF
Tagged-Image File Format - Photoshop can write LZW compressed or uncompressed 
file which a color depth up to 32-bit file. TIF is a wildly used file format. 

Helpful Links:
http://www.planetphotoshop.com
http://www.good-tutorials.com
http://www.handson.nu
http://www.phong.com
http://www.arraich.com
http://www.icehousedesigns.com



TERMINOLOGY GLOSSARY 

ASCII
American Standard Code for Information 
Interchange. A world-wide standard for code 
numbers used by computers, it consists of 
128 upper and lowercase letters. Since the 
ASCII code makes no provision for non-
English letter accents and forms, currently 
most computers use an extended character 
set that accommodates technical, graphic, and 
non-Western characters. A "plain ASCII" file is 
just a normal text file.

AU files
A filename extension that denotes audio data.

Anonymous FTP
See FTP.

Archie
A method used to search databases on the 
Internet. Archie finds FTP sites related to the 
title, keyword, or subject you indicate.

Audio files
See au., midi, and .wav files. 

Bandwidth
The amount of data that can be handled by a 
data communication link, for example, a 
telephone line. Essentially it is a measurement 
of network capacity and the amount of data 
that can flow through a communications 
circuit per second.

The broader the bandwidth, the more data 
can flow. For example, a 14.4K modem can 
move 14,400 bits per second. A T1-line, on 
the other hand, is capable of sending 
1,544,000 bps.

Baud
A measurement of the speed data travels. 
Related to, but not identical to, bps.

BBS
Bulletin Board System. A computerised 
system which allows people to dial in through 
their phone lines to exchange e-mail, chat, 
and generally socialise. BBSs tend to be small 
and focused on local people and issues.

BinHex
Binary Hexadecimal. A method for converting 
binary files into ASCII. Necessary when using 
transport methods which only accept ASCII 
text, such as normal e-mail.

Bits
Binary Digit. One digit of a binary number, 
either zero or one. Bits are the smallest 
components of bytes.

BMP files
Microsoft Windows Bitmap format. A graphic 
file format.

Bps
Bits per second. A measurement of data 
transmission speed.

Browser
A software programme (such as Netscape or 
Internet Explorer) that enables you to access 
Internet resources. This is particularly used in 
relation to the WWW.

Users can read hypertext documents and 
navigate from one document to another. Most 
browsers are user-friendly, with button bars 
and pull-down menus. Many support images, 
forms, and audio files.

Byte
A unit of eight bits. Computer storage devices 
such as disk drives and memory usually 
measure their capacity by the number of 
bytes they can store. A more easily used unit 
of measure based on bytes is Megabyte.

CERN
The European Laboratory for Particle Physics. 
Located in Switzerland and France, CERN is 
the place where Tim Berners-Lee first 
originated the World Wide Web in 1989.

CGI
Common Gateway Interface. A standard for 
gateways, which interface between external 
programs and Web servers.



Client
A software program which contacts and 
receives its data from a server software 
program, which is often located on a different 
computer.

Cyberspace
Term coined by William Gibson in his novel 
"Neuromancer." Used today by the media to 
mean the entire Internet and all the resources 
available on the Internet.

DNS
Domain Name System. A distributed data 
query system used to translate hostnames 
(205.94.220.10) and e-mail addresses 
(betty@boop.com) into Internet IP addresses.

Dial-up Connection
A network connection where one computer 
dials up another over a telephone line. Slower 
than a direct connection.

Direct Connection
A network connection from one computer to 
another made through a permanent and high-
speed method such as Ethernet or T-1 
connections. Usually leased from a common 
carrier.

Domain Name
A domain name is a unique name that 
identifies an Internet site, such 
ashttp://www.mysite.co.za. Mysite identifies 
the host of the site, in this case mysite;.co.za 
denotes a commercial site in South Africa. 
Other domain extensions include "ac", "edu," 
"org," and "gov," meaning, respectively, 
academic, educational, non-profit, and 
government hosts.

Download
To transfer files from a remote computer to 
the local computer. Downloading is the 
receiving of the file, uploading is the 
transmitting of the file. 

E-cash
A way to make purchases over the Internet 
using an electronic transfer of funds. 
Eliminates the need to transmit a credit card 
number over the Internet. E-cash software 
holds electronic money on the user's 
computer.

E-mail
Electronic mail; also, email, e-mail, or Email. 
Responsible for reviving the lost art of written 
communication. E-mail is an electronic mailing 
system whereby you can send messages over 
the Internet.

You can send correspondence down the hall or 
across the planet in seconds. A typical e-mail 
address consists of two parts separated by an 
@ sign, such asjohn@myserver.uct.ac.za.

Emoticons
Also known as "smileys." A way to convey 
tone in written conversations in lieu of spoken 
and physical cues. Emotions such as 
happiness, sadness, and tongue-in-cheek 
signals are displayed with the use of colons, 
dashes, periods, etc. Turn your head to one 
side to read. : = (

Enhanced Mosaic
Luckman Interactive's Web Browser. Part of 
the Net Commander integrated Internet 
access suite.

Ethernet
A common method of connecting computers in 
a LAN. Ethernet transfers data much faster 
than a dial-up connection--10 million bps.

External Viewer
An application for viewing multimedia 
information, such as audio files, within Web 
pages. External viewers are available for 
audio, video, and virtual reality data, among 
many others.

FAQ
Frequently Asked Questions. These are files 
which are maintained by people so that those 
who are starting out have a rich source of 
information on the subject in which they are 
interested.

Originally referring a list of questions and 
answers aimed at new users of a Usenet 
newsgroup, FAQs are also employed on the 
Web to convey information quickly and 
concisely. It is considered good netiquette to 
read the relevant FAQs on a subject before 
posting questions in a newsgroup.



Finger
A software tool for finding people by name on 
the Internet. For security reasons many 
private computer systems do not respond to 
incoming Finger requests.

Firewall
A gateway which protects an organisation's 
internal Local Area Network (LAN) from 
external access and tampering from a Wide 
Area Network (WAN), such as the Internet. 
Many firewalls disable the functionality of real-
time audio and video players such as 
RealAudio.

Flame
A verb which means to post an excessively 
rude and personally insulting response to 
another's message. People who post 
controversial messages on Usenet often get 
flamed in response.

Freeware
Software available without charge through the 
Internet, bulletin boards, and user groups. 
Not synonymous with shareware.

FTP
File Transfer Protocol is the standard Internet 
protocol for moving files from one computer 
to another. 

GIF
Graphics Interchange Format. A colour 
graphics file format owned by Compuserve. 
Useful for higher-resolution images because of 
its file compression feature.

Gateway
Hardware or software which translates data 
between computers using incompatible 
protocols. For example, Compuserve and 
America Online have gateways to the Internet 
and the World Wide Web.

Gopher
Menu-based format used in gopher client 
software and most Web browsers for 
accessing information on the Internet. You 
can gopher to a Telnet or FTP site.

Graphics files
See BMP, GIF, and JPEG.

HTML
Hypertext Markup Language. The formatting 
language of the Web. It determines the 

appearance of and defines the links (which 
permit navigation through linking documents 
together) in a Web document. This page is an 
example of HTML text.

HTTP
Hypertext Transfer Protocol. The basis of the 
Web, this protocol allows the exchange of 
HTML documents across the Web. When found 
at the beginning of an URL (page address), it 
indicates that the address is a Web site.

Hardware
The physical components of a computer, such 
as the monitor, CPU, keyboard, disk drives, 
etc.

Home Page
The top-level HTML document for a Web site. 
Other pages can be accessed by following 
hyperlinks from the top-level page. Usually 
called index.htm/l.

Hotlist
Also, hot links. A hypertext list of links to, in 
someone's opinion, interesting or valuable 
sites on the Web.

Hypertext
Called hyperlinks, or more commonly, links. 
How information on the Web is connected 
together. Clicking on the highlighted hypertext 
in a Web document takes you to another page 
in that document or to a completely different 
Web site. Instead of processing information in 
a linear way, hyperlinks let us get the 
information in the order that makes the most 
sense to us.

IP Address
A number consisting of four parts-each part 
containing numbers between 1 and 255--
separated by dots, such as 206.117.25.3. 
Every computer on the Internet has a unique 
IP address and a unique Domain Name. The 
Domain Name Server translates between the 
two.

IRC
Internet Relay Chat is a global network of 
people talking to each other in real-time over 
the Internet by typing messages via their 
keyboards. A text-based live chat facility 
divided into a number of topics called 
"channels." Networks of IRC servers all over 
the world connect IRC users.



ISDN
Integrated Services Digital Network. A digital 
communications network built over existing 
telephone lines that can carry voice, data, and 
video transmissions. ISDN gives the user a 
faster Internet connection than a modem 
does.

To give an idea of ISDN's speed, an ISDN line 
transmits 64,000 to 128,000 bps, compared 
to the fastest available analogue modem's 
speed of 28,800 bps.

ISP
An Internet Service Provider is a company 
that gives you access to the Internet. They 
are companies with dedicated, high-speed 
Internet connections that sell access to the 
Internet to individuals and other companies. 
Providers offer dial-up, ISDN, T1, and other 
types of Internet connections.

Imagemap
An image in an HTML documents that has "hot 
spots" which when clicked, take the user to 
other documents.

Inline Image
A graphic image within an HTML page meant 
to be displayed along with text.

Internaut
An internet user. (Robert French Dictionary)

Internet
Originally used by the military, scientific and 
academic communities. Can be thought of as 
a world-wide network of networks using a 
common addressing format. Not originating 
from any one source and owned by no one, 
the Internet is constantly changing and 
growing-by connecting to it, you become part 
of it. The Web is part of the Internet.

JPEG
Joint Photographic Experts Group. A digital 
image compression method, also a graphic file 
format. Best used for photo-realistic grey-
scale and colour images, rather than line 
drawings or cartoon images.
 
LAN
Local Area Network. A computer network 
limited usually to a single physical location 
such as a floor of a building. See WAN.

LISTSERV
Mailing list software which distributes one e-
mail message to many addresses at once.

 

MIDI
Musical Instrument Digital Interface. A 
hardware protocol for exchanging musical 
information between computers, synthesisers, 
and instruments.
MPEG
Motion Pictures Experts Group. A standard for 
compressing moving images for transmission. 
A file format for encoding video and/or audio 
data.

MUD
Multi-User Dimension, or Multi-User Dungeon. 
Originally used for role-playing games, now 
also used for education and business 
conferences. Multiple users can interact at the 
same time within in a virtual environment.

Mailing List
A distribution list sent to list subscribers. 
LISTSERV is an automated distribution 
program for mailing lists.

Megabyte
Short for 1,048,576 bytes.

Mirror site
A server which duplicates or mirrors, the files 
in another site. Users can choose to connect 
to their closest site. For example, a popular 
U.K. site may be mirrored at several sites in 
the U.S. to speed access time for North 
American users, and reduce the load on the 
originating site.

Modem
An acronym for Modulator/Demodulator. A 
piece of hardware which allows your computer 
to communicate using the telephone system.

Mosaic
Name of the first graphical World Wide Web 
browser, developed by NCSA. The graphic Web 
browsers today are either actual or spiritual 
descendants of the original Mosaic. Enhanced 
Mosaic, Luckman Interactive's browser, is 
contained within the Net Commander 
integrated Internet access suite.



NIC1
Network Information Centre. An office which 
maintains and handles information about a 
network. The NIC in charge of the entire 
Internet is called InterNIC. It assigns IP 
addresses and high-level Domain Names.

NIC2
Network Interface Card. A physical device, 
such as an Ethernet card, that attaches to the 
computer and allows it to communicate over a 
specific type of network. Common ones 
include Ethernet, Token Ring, and FDDI.

Netiquette
General code of manners for social 
interactions over the Internet. As in any 
community, good manners make life more 
pleasant for everyone. The Netiquette Home 
Page is a good place to bone up on Internet 
deportment, especially before joining a 
newsgroup discussion.

Newsgroups
Discussion groups on Usenet, a network not 
the same as the Internet, but which can be 
accessed from the Internet, among other 
channels. Newsgroups consist of millions of 
people posting and reading thousands of 
messages about innumerable topics.

Newbie
Name for someone new to the Internet. 
Usually not considered complimentary. 

PGP
Pretty Good Privacy. An encryption application 
created by Phillip Zimmerman. PGP allows the 
private and authenticated transmission of data 
over communications networks. Using Public-
Key Cryptography technology as a base, PGP 
does not require the use of secure channels.

POP
A Point of Presence is a location where you 
can get dial-up access. 

OR

POP
Post Office Protocol. An application that allows 
users to obtain their e-mail from a server.

PPP
Point to Point Protocol. A protocol mostly used 
for establishing TCP/IP connections remotely 
through a dial-up connection. It is a method 
of connecting computers to the Internet via a 
telephone line and modem.

Password
The code which allows a specific user to gain 
access to a computer system.

Post
To send a message to a public medium, such 
as a Usenet newsgroup, or a mailing list. Also 
used to mean the actual message.
Protocol
An agreed set of procedures that ensures 
compatibility between the receivers and the 
transmitters of data. 

RAM
Random Access Memory. High speed memory 
used by the computer to store temporary 
information such as a running application. A 
larger amount of RAM often increases 
application execution speed and allows more 
applications to run at the same time.

RFC
Request For Comments. A process for creating 
standards on the Internet, where new 
standards are proposed and marked as 
Request For Comments. Discussion and 
eventual adoption of new standards evolve 
from the proposals.

Real-time video
Video transfer that makes use of data 
streaming rather than downloading to allow 
the users to view a video file almost 
instantaneously.

Router
A device which allows connections between 
two computer networks.

SGML
Standard Generalised Markup Language. 
Providing conventions for other mark-up 
languages, SGML defines the formatting of a 
text document, including hypertext, by 
describing a document's information rather 
than its visual components.



SLIP
Serial Line Internet Protocol. A protocol for 
using a telephone line-the serial line- and a 
modem to establish TCP/IP connections 
between two computers. SLIP is being 
gradually replaced by the more secure and 
versatile PPP.

Search Engines
Search Engines are computer databases which 
attempt to catalogue all the information on 
the Internet. Documents can then be 
retrieved by typing in key words and phrases, 
or other user-specified criteria. A few of the 
search engines you can find on the Web are 
Yahoo, Webcrawler, and InfoSeek.

Server
Software (or a hardware and software 
combination) which provides a specific kind of 
service and information to client software 
which may run on other computers. For 
example, Web servers allows one to access 
the Web documents located on them.

Shareware
Software, distributed for trial use, without 
charge. The author requests payment if the 
software is found useful.

Shell Account
A dial-up account to an ISP which only offers 
terminal emulation access to a UNIX shell 
account, and does not allow use of graphical 
applications directly from your machine.

Smiley
See emoticons.

Spamming
This is sending loads of unacceptable junk 
mail to e-mail lists, newsgroups, and so on.

Spider
A term used to describe an application which 
travels the World Wide Web collecting 
information. Many Web search engines use 
spiders to collect data from which they build 
their indices.

Static Address
An IP address which is permanently attached 
to a computer connected to the Internet; as 
opposed to a Dynamic Address, which may 
change every time the computer establishes 
an Internet connection. 

T1
A fast direct connection used mostly by large 
companies, universities, and ISPs to the 
Internet. For comparison's sake, the T1 
transmits at 1,544,000 bps and a 28K modem 
transmits at 28,000 bps.

TCP/IP
The Transmission Control Protocol / Internet 
Protocol are two communication protocols by 
which all information is sent over the Internet. 
It allows computers with different operating 
systems to communicate with each other.

Telnet
An application you can use to log in to a 
distant computer as if you were part of its 
network.

Trolling
To act in a manner which deliberately elicits 
flames. 

UNIX
Written in the C programming language, UNIX 
is a multi-platform, multi-user, multi-tasking 
operating system. The language used by 
many applications on the Web, UNIX is known 
for its lack of user-friendliness.

URL
Uniform Resource Locator. Each Web page's 
unique address, for example: -http:
//www.uct.ac.za. Made up of distinct parts, it 
can give clues to the kind of host which is the 
sources source of the site. For example, in the 
American URL address http://harvard.edu, the 
".edu" designates an educational domain. 
Commercial and nonprofit organisations are, 
respectively, ".com," and ".org." Other 
extensions include ".gov, for government, 
".mil" for military, and ".net" for network.

In South Africa domains end with "za".

Usenet
User Network. A decentralised, networked 
system of news and discussions topics, which 
are called newsgroups, where people can 
exchange news and views. 

Veronica
Very Easy Rodent Oriented Net-wide Index to 
Computerised Archives. A database and 
search engine for finding information on 
gopher servers.



Video files
See MPEG, real-time video.

VRML
Virtual Reality Modelling Language. A 
language authoring standard which describes 
3-D environments on the Web. The VRML 
specification allows users to participate in 
interactive 3-D simulations on the Web, for 
example, a room in which users can walk, and 
pick up objects and rotate them. 

WAIS
Wide Area Information Server. A commercial 
indexing tool for keyword searches of text
documents on the Internet and other WANs.

WAN
Wide Area Network A network which 
physically covers a large area. See LAN.

WAV files
A filename extension that denotes Windows 
audio files.

WebBot component
According to Microsoft "WebBot components 
add functionality without complex 
programming" in both FPXpress and FP98. A 
WebBot is a "dynamic object" on a Web page. 
WebBots may add Time Stamp, Include, and 
Search features to Web pages, as well as 
forms handling and navigation bars.

Web Browser
A browser, such as Netscape Navigator, or 
Microsoft's Internet Explorer, provides a 
window to the Web, allowing you to follow 
hyperlinks effortlessly, from networks in New 
Zealand to Zurich, and from Zurich to Africa, 
with a few clicks of the mouse.

Web Page
A Web site is made up of a series of HTML 
pages, connected to each other by hyperlinks.

Web Server
Server software-and sometimes the 
hardware-which makes access of HTML 
documents possible through HTTP.

Web Site
An organised group of Web pages located on 
the same Web server.

Webmaster
Person in charge of managing and maintaining 
a Web site.

WinSock
Windows Sockets Specification. Provides an 
Applications Program Interface standard for
Windows TCP/IP software development.

World Wide Web
WWW, also, the Web. The most user-friendly 
part of the Internet, offering graphics, sound, 
video, and hypertext links to other Web pages 
and Web sites. Refers to all Web servers on 
the Internet, as well as the information on the 
Web servers.

Worm
Among other definitions, a robotic indexing 
program creating a database which can be 
accessed or keyword-searched over the Web.

WWW
The World Wide Web is the easy-to-use 
graphic interface which allows you to move 
about the Internet by clicking on certain 
images or words.

WYSIWYG
What You See Is What You Get. This refers to 
any application which allows you to see an 
approximation of what it is you are creating. A 
Word Processor is WYSIWYG, as are the 
various web-editors.



SUPPLEMENTARY READING SUGGESTIONS

What is Web 2.0: Design Patterns and Business Models for the Next 
Generation of Software
http://www.oreillynet.com/pub/a/oreilly/tim/news/2005/09/30/what-is-web-20.html

What is Social software (2003)
http://www.darwinmag.com/read/050103/social.html

Culture of collaboration (2001)
http://www.darwinmag.com/read/110101/ecosystem.html

Gamer girls unite – Alida game for women
http://www.gamergirlsunite.com/content.php?review.90

Soapbox: ARGs and How to Appeal to Female Gamers
http://www.gamasutra.com/features/20051129/phillips_01.shtml

Prepared by: Iwona Erskine-Kellie
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